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ABOUT THIS COURSE 

Course Prerequisites 

This manual is designed for users who are comfortable using Windows and Microsoft Edge. 
Students should complete the first part of our Microsoft 365 courseware before beginning 
this course. 

 

Course Overview  

Welcome to our Microsoft 365 Excel Online courseware. Excel Online is Microsoft’s cloud-
based, easy-to-use spreadsheet program.  

This course is intended to help all users get up to speed with Excel Online. We will cover: 

• Getting started with the app 
• Working with formulas and functions 
• Formatting parts of a worksheet 
• Using pictures, tables, charts, and PivotTables 
• Finalizing workbooks 

 

Course Objectives 

By the end of this course, users should be comfortable with creating a new spreadsheet, 
working with basic formulas and functions, and making a spreadsheet look professional and 
presentable. 
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How to Use This Book 

This course is divided into seven lessons. Each lesson focuses on several key topics, each of 
which are broken down into easy-to-follow concepts. At the end of each topic, you will be 
given an activity to complete. At the end of each lesson, we will summarize what has been 
covered and provide a few review questions for you to answer. Supplemental learning for 
selected topics is provided in the form of Lesson Labs at the end of this book. 
 
NOTE: In order to complete this course, each student will require a Microsoft account. 
Students should upload the course’s Exercise Files to their OneDrive account prior to 
beginning the course. A local copy of these files is also required for some activities. Due to 
the nature of Excel Online, it is recommended that students complete all lessons in order.  
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LESSON 1: 
GETTING STARTED 

 

Lesson Objectives 

In this lesson you will learn how to: 

• Get started with Excel Online 

• Describe the basic components of Excel 

• Manage workbooks 

• Get help in Excel Online 
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TOPIC A: Getting Started with Excel Online 
 

Excel Online is the cloud-based version of Microsoft’s spreadsheet program. It offers many 
tools for managing numerical data, as well as the ability to add charts, shapes, and much 
more. Best of all, Excel Online’s interface is intuitive (particularly if you have used the 
desktop version), so the features you need will be easily accessible. 

 

 

Topic Objectives 

In this session, you will learn how to: 

• Log into Microsoft Office and start Excel Online 

• Identify the components of the Excel Online interface 

• Create a new workbook 

• Close Excel Online 
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Logging into Office 365 

Your first step before using Excel Online is to log into Office 365 with your Microsoft 
account. To start, open your internet browser and navigate to the login page at: 
https://login.microsoftonline.com:  

 

  

https://login.microsoftonline.com/
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If prompted, choose the sub-account to sign in with:  
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Now, you will see the Microsoft Office Home page:  
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Launching Excel Online 

To start Excel Online, click the icon on the Microsoft Office landing page:  
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Excel Online will then open:  
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The Excel Online Interface 

Excel Online looks and operates in much the same way as its desktop counterpart:  

 

1: Title Bar 

The top left part of the screen contains the name of the current file. You may also see more 
information about the file (for example, here you can see it has been saved). You can click 
the file name to change it.  

You will also see the app launcher (where you can access other Office 365 apps), and the 
name of the app (Excel).  

2: Search Bar 

The Search Bar allows you to search for a variety of things related to your document. You 
can search for an action to complete (such as changing the font color or adding 
highlighting), locate words in your document, or search for a person’s name that is 
connected to your Microsoft account. Type in the search bar to begin showing suggested 
results.  

3: Sharing Commands 

Click this button to share the current document.  
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4: Tabs 

Groups of similar commands are organized under tab names. Click a tab to view the 
commands in the ribbon.  

5: Ribbon Interface 

Displays tab commands organized into groups. If you click the different tabs, you will see 
the commands change. Notice, too, that some of the commands might be grayed out. This 
is because those commands are only usable in certain situations.  

Like the desktop version of Excel, Excel Online also features contextual tabs. These are 
special tabs that only appear when you are working with a specific object or group of 
information. For example, if you were to insert and select a shape, you would see a 
contextual tab offering commands for that object:  

 

6: Formula Bar 

The Formula bar allows you to enter data in a cell.  

7: Working Area 

The data in the currently open file will be shown here.  

8: Worksheet Commands 

Every Excel file is properly referred to as a workbook, which can contain one or more 
worksheets. Click the tabs to switch between worksheets.  
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9: Status Bar 

This bar displays running calculations and other information about the workbook.   

 

Creating a New Workbook 

When you open Excel Online, you will be prompted to choose an existing workbook or 
create a new one. For this example, let’s create a new, blank workbook by clicking the 
related thumbnail:  
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The workbook will be created and saved to either your personal OneDrive account or 
SharePoint space:  
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Note that this file will use “Book” as the default name. (A number may be added to the end 
if a workbook with the same name already exists in the save location.) To change its name, 
click the current name on the title bar, type the new name in the File Name field, and close 
the menu by clicking in the working area of the workbook:  
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Now, you can add your data just as you would in the desktop version of Excel:  
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Then, click the New category and click the thumbnail for the workbook you want to create:  

 

 

Closing Excel Online 

Remember that Excel Online is constantly saving your workbook, so you do not have to 
worry about losing data when closing Excel Online, and you do not have to manually save it 
either. So, once you have finished your work, close the browser tab (or browser) in which 
Excel Online is open.   
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Activity 1-1: Getting Started with Excel Online 

In this activity, you will launch Excel Online and explore its interface.  

1.  To begin, turn on and log into your computer. Open Microsoft Edge and navigate 
to https://login.microsoftonline.com:  

 

2.  Enter your Microsoft account name and click Next:  

 

https://login.microsoftonline.com/
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3.  If prompted, choose the sub-account to sign in with:  

 

(If you do not see this prompt, skip to the next step.) 

4.  Finally, enter your password and click Sign In:  
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5.  On the Microsoft Office Home Page, click Excel:  

 

6.  The Excel Online start screen will now be displayed. Click the New blank workbook 
thumbnail:  
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7.  By default, this workbook will be titled “Book”. Let’s change this by clicking on the 
title:  

 

8.  A dropdown menu will open. Under the File Name field, replace the existing text 
by typing “Activity 1-1”:  
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9.  Then, click inside the working area of the workbook to close the menu:  

 

10.  Now, click cell D2 to select it:  

 

(Remember, this is the location where Row 2 and Column D intersect.)  
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11.  Type your name and press Enter to commit it to the cell:  

 

12.  This activity is now complete. Close the Excel browser tab.  
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TOPIC B: Getting to Know Excel 
Before we dive further into Excel’s features, let’s take a moment to learn about some Excel 
terminology and how to navigate in the app.  

 

Topic Objectives 

In this session, you will learn: 

• What spreadsheets, worksheet, and workbooks are 

• How to describe columns, rows, cells, ranges, and formulas 

• How to navigate in Excel 
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What are Spreadsheets, Worksheets, and Workbooks?  

Spreadsheets are paper or digital workbooks that are typically used to store, sort, and work 
with data. This data, while most often numerical, can also include text, shapes, and pictures. 
Spreadsheets consist of intersecting rows and columns that form cells, which contain the 
data. 

Worksheets are a digital form of spreadsheets. Typically, worksheets display columns with 
alphabetical headers and rows with numerical ones.  

A workbook is a collection of one or more worksheets. By default, new blank workbooks 
only include one worksheet, but you can add others if needed:  

 

If the workbook that you are using includes more than one worksheet, you can switch 
between them by clicking the tabs. The name of the worksheet that you are presently 
working with will be in bold type on a white background. In the previous image, Sheet1 is 
currently active.  

 

What are Columns, Rows, Cells, and Ranges?  

Columns, rows, and cells make up the fundamental components of a worksheet. A column 
is a vertical series of adjacent cells from top to bottom. A row is a horizontal series of cells 
from left to right. A cell describes the intersection of a row and column: 

 

Each column has an index letter. Since there are only 26 letters, and there can be far more 
than 26 columns on a spreadsheet, the columns after column Z are indexed by the letters 
AA, AB, AC, and so on until the last column (up to XFD, over 16,000). Each row has an index 
number, from 1 through 1048576. Each cell is given a name in the “ColumnRow” format, 
with the top left cell referenced as A1. (In the example above, the word “cell” is at C3.) 
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The active cell is the name given to the cell that is currently selected.  

A cell range (or simply “range”) is defined as a series or block of adjacent cells. Unlike the 
desktop version of Excel, Excel Online does not allow you to formally define ranges. 

 

Navigating in Excel 

You will find scroll bars on the right and bottom sides of Excel workbooks:  
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To view a different part of the current worksheet, click and drag the scroll bar:  

 

Keyboard Navigation Options 

Sometimes the keyboard can be an even quicker way to navigate through worksheets. 
Below are some common keyboard shortcuts that you may find useful:  

Move one cell in any direction Up, down, left, right arrow keys 

Go to column A Home 

Return to cell A1 Ctrl + Home 

Scroll up or down by one screen Page Up or Page Down 

Move one cell to the right Tab 

Move one cell to the left Shift + Tab 

 

Excel Formulas 

When cells contain numerical data, you can perform mathematical operations on the cell 
content using formulas and functions. The results of these operations will be shown in the 
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cell that contains the formula. Formulas can be simple, like adding two cell values, or quite 
complex, involving multiple mathematical operations. 
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Activity 1-2: Getting to Know Excel 

You have been given a spreadsheet that requires a basic formula to calculate the total sales 
based upon the number of products that were sold. You will use the tools covered in this 
topic to complete this task. 

1.  To begin, open Microsoft Edge and log into Office 365. (Refer back to Activity 1-1 if 
you need help.)  

2.  Click the OneDrive icon on the Microsoft Office Home Page:  
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3.  Click this course’s Exercise Files folder to view its contents:  

 

(You may notice that the file we created in the last activity is also listed here.)  

4.  Click the Lesson 1 folder:  
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5.  Click “Activity 1-2” to open it:  

 

6.  The workbook will now open:  
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7.  Ensure that Sheet1 is displayed. Cells A2 and A3 in this sheet have very similar 
formulas but display very different results. Click each cell and look in the formula 
bar to find the difference:  

         

8.  As you can see, the parentheses completely change the result of this formula. Let’s 
move to Sheet2 by clicking its worksheet tab:  

 

9.  This sheet contains a basic table with a few formulas calculating the data. Click cell 
C2 to see how it is calculated:  
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10.  Click cell C3 to see how it is calculated:  

 

Which method do you think is better?  

11.  Use the preferred method to calculate row 4. Do not forget to press Enter after 
inputting the formula:  

 

12.  Now, click in cell C5 and type: =SUM(C2,C3,C4):  

 

13.  Press Enter to calculate the formula:  
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14.  Close the Excel Online browser tab to complete this activity.  
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TOPIC C: Managing Workbooks 
In the last section, you became familiar with the Excel Online interface. In this topic, we will 
look at the basic options for managing those workbooks.  

 

Topic Objectives 

In this session, you will learn how to: 

• Open, save, share, and print workbooks 

• Edit a workbook in the desktop version of Microsoft Excel 

• Use the Accessibility Checker 
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Opening a Workbook 

To open a workbook in Excel Online, click the File tab:  

 

Click Open to display the Open category. Click the workbook you want to open:  
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(Note that the workbook must be stored online in your Microsoft account to be able to 
open it in Excel Online.) 

The workbook will open in a new tab:  

 

 
Editing Your Workbook in Excel Desktop 

To edit the current workbook in the desktop version of Excel, click Editing → Open in 
Desktop App:  

 

Excel will open on your desktop and download the current workbook to your computer. You 
may need to click Enable Editing to continue.  

Even though you are working with the desktop version of Excel, any changes that you make 
to this file will be automatically synced to the online file. This way you can have the full 
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functionality of Excel for desktop, combined with the versatility and portability of Excel 
Online without having to worry about multiple versions of the same file.  

When you are finished working with the desktop version of Excel, close the program. Save 
your changes if prompted:  

 

Then, return to your internet browser. The workbook will now be updated:  

 

(If prompted, click Resume editing here.)  
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Accessing Save Options 

Although Excel Online is designed for workbooks in the cloud, you do have access to other 
save options. To start, click the File tab:  

 

Now, click the Save As category:  
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You will see a variety of save options in the right pane of the menu. Click the desired option 
to open the appropriate dialog box, where you can customize various save options and 
complete the process. 

Let’s look at the dialog box for each command.  

Save As  

Opens the Save As dialog box, where you can choose the online location where you want to 
save the workbook and change the file name. Click Save to complete the process: 
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Rename 

Opens the Title bar. Enter the workbook’s new name under the File Name field, and click 
OK to complete the process:  

 

Download (Copy or ODS) 

Prepares the file for download in the specified format. (Saving the workbook as a copy will 
use Excel’s default format, .xlsx.) When the download is complete, use your internet 
browser to open and view it:  
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Using the Accessibility Checker 

To check your workbook for possible accessibility issues, click Review  Check 
Accessibility:  

 

The Accessibility task pane will then be displayed on the right-hand side of your screen:  

 

Its contents are divided into three sections that list different types of problems. Click any 
item to go to that workbook object and resolve the problem.  
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Printing a Workbook 

To print a workbook from Excel Online, click File  Print  Print, or press Ctrl + P:  

 

The Print Settings dialog box will open, where you can set various print options:  

 

Once you click Print to send the workbook to the printer (or click Cancel to stop the 
process), you will return to the workbook.  



Microsoft 365 Excel: Online 

 

43 

 

Sharing a Workbook 

Since Excel Online workbooks are always saved to a cloud-based location, it is easy to share 
workbooks with others. To start, click File  Share  Share, or click the Share icon in the 
upper toolbar:  
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The Send link dialog box will open:  

 

At the top of the dialog box (1), there is a section that shows which access level users will 
have to the file. (Clicking this section will open a separate dialog box with options to choose 
a group, change editing permissions, and set an expiration date.) Advanced permissions can 
be managed by clicking the ellipses (…) button at the top of the menu.  

In the main part of the dialog box, you can enter the names, group names and/or email 
addresses (2) of the people you want to share with, as well as the message (3) that will be 
sent to them. When you are ready, click Send (4). (Notice that there are additional options 
(5), at the bottom of the dialog box, such as copying a link or sending a message with a link 
via Microsoft Outlook.)  
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Once you have entered the necessary information, click Send. Then, you will receive a 
confirmation. Close this pop-up to return to Excel Online:  

 

The recipient will receive a link via email. They can click Open to view the workbook in Excel 
Online:  
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Activity 1-3: Managing Workbooks 
In this activity, you will open and export a workbook. Ensure your Exercise Files have been 
uploaded to OneDrive before starting this activity.  

1.  To begin, open Microsoft Edge and log into Office 365. (Refer back to Activity 1-1 if 
you need help.)  

2.  Navigate to Lesson 1 of your Exercise Files folder on your OneDrive account. Open 
Activity 1-3:  

 

(Refer back to Activity 1-2 if you need help.)  
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3.  The workbook will now open:  

 

(If the document opens in Reading View, click Edit Document, then Edit to enter 
Editing View.)  

4.  First, let’s check the workbook for accessibility issues. Click the Review tab and 
click Accessibility Checker:  
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5.  You should see that the workbook has no issues. Close the task pane:  

 

6.  Now, let’s download a copy of the workbook. Click the File tab:  
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7.  Click the Save As category:  

 

8.  Click the icon next to Download a Copy:  
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9.  When you see confirmation that the file has finished downloading, close this 
browser tab to complete the activity:  
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TOPIC D: Getting Help in Excel Online 
By now, you will have noticed that you can do a lot of things with Excel Online, and we have 
only scratched the surface. It is virtually impossible to memorize everything it offers, and its 
features are constantly changing. Luckily, Excel comes with a tool that allows you to find 
answers to your questions. You can also submit your feedback or suggestions about the 
features of Excel.   

 

Topic Objectives 

In this session, you will learn how to: 

• Use the Help tab 

• Give feedback about Microsoft Office 
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Using the Help tab 

The Help tab contains a variety of help tools. Click Help to open the Help tab:  

 

Then click Help to open the Help menu:  

 

Now, using the search bar, you can search for help articles. You can perform a new search 
for help information by typing keywords into the search bar and pressing Enter. After a 
moment, any results Excel thinks are relevant will appear in a list:  
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Click one of the topics in that list to view more information about it:  
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The help article will open:  
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Giving Feedback About Office 

Microsoft gives users a way to submit positive or negative feedback about their products 
directly in PowerPoint Online.  

To give feedback, click Feedback under the Help tab:  

 

You can also click Give Feedback to Microsoft in the status bar.  

Then, you can choose whether to submit feedback about something you like, something 
you do not like, or a suggestion:  
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Clicking on an option opens a text field where you can type your comment. Click Submit to 
finish:  
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Activity 1-4: Getting Help in Excel Online 
In this activity, you will explore Excel Online’s help features.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 1-4 from 
OneDrive. (Refer back to Activity 1-2 and 1-3 if you need help.)  

2.  First, let’s learn about some of Excel Online’s newest features. To start, click the 
Help tab:  

 

3.  Then click Help:  

 



Microsoft 365 Excel: Online 

 

58 

4.  A new sidebar menu will open. In the search field, type “new” and press Enter:  

 

5.  Click the “What’s new in Excel for the web” article:  

 

(If you do not see this topic, choose any other link on the page.)  
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6.  Scroll through the article. When you are finished, close the menu:  

 

7.  Close this browser tab to complete this activity.  
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Summary 
In this lesson, we learned about some of the terms used when working with Excel, and how 
to use the basic features of the Excel interface. We also learned how to create, view, 
navigate in, save, share, and print workbooks. We wrapped up the lesson with information 
on using Excel Online’s help features.  

 

 

Review Questions 
1. Where can Excel Online open documents from?  

 

2. What command opens a menu that allows you to search for help articles in Excel 
Online?  

 

3. In Excel, what is a column and a row?  

 

4. True or False: Since Excel is a cloud-based application, you cannot save workbooks 
offline.  

 

5. How are cells typically referenced in Excel?  
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LESSON 2: 
WORKING WITH DATA 

 

Lesson Objectives 

In this lesson you will learn how to: 

• Use formulas and functions 

• Work with data, rows, and columns 

• Sort and filter data 
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TOPIC A: A Closer Look at Formulas 
Now that we have learned about the Excel interface, it is time to learn about Excel formulas. 
We will start with the basics, including where and how to enter formulas in Excel.  

 

Topic Objectives 

In this session, you will learn about: 

• The formula bar 

• The elements of an Excel formula 

• Common mathematical operators and their order of operations 

• Excel cell references 
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The Formula Bar 

You can enter functions and formulas in the formula bar, just below the ribbon:  

 

(The fx button on the left side of the formula bar will open the Insert Function dialog box, 
which we will discuss in the next lesson.)  

You can tell if a cell contains a formula by making it active. If there is a formula in the active 
cell, it will be shown in the formula bar. Here, the SUM function is being used to add data 
from cells C2 through to F2:  
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Elements of an Excel Formula 

Here are some important things to note about formulas.  

• Formulas are always preceded by an equals sign (=).  

• Formulas can contain cell references (such as “A1”), numbers (such as “23”), or 
functions [such as “SUM(B2:B9)”].  

• =A1+23, =d2-c2, and =B10+b11/C6 are all valid formulas; cell references are not 
case-sensitive.  

• You can enter a formula by typing directly into a cell or into the formula bar:  

 

• If you include a cell reference in a formula (like “=B3*6”), and that cell reference 
itself contains a second formula (like “=B1+B2”, stored in B3), that second formula 
(“=B1+B2”), will be evaluated first, and the result will be used in =B3*6.  

 

Mathematical Operators 

Excel uses eight basic mathematical operators:  

Name Symbol Example 

Exponent ^ 10^2 = 100 

Division / 10/2 = 5 

Multiplication * 10*2 = 20 

Addition + 10+2 = 12 

Subtraction - 10-2 = 8 

Equivalence = 10 = 10 

Greater Than > 10>2 

Less Than  < 2<10 
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The Order of Operations 

The common mathematical operators shown above are listed from top to bottom in order 
of precedence. This means that Excel does not simply calculate expressions from left to 
right; certain operations are performed before others. Multiplication and division, addition 
and subtraction, and the greater than/less than operations each have equal precedence.  

You can impose your own order of operations by enclosing expressions in parentheses (). 
The operations inside the parentheses will be evaluated before the operations outside. If 
you have parentheses within parentheses, such as ((2+3)*4), the expression in the inner 
parentheses, (2+3) =5, will be evaluated first, and the result will be used to evaluate the 
expression in the outer parentheses, (5*4) =20. 

One easy way to remember precedence order is to remember the word “BEDMAS,” which 
stands for Brackets (Parentheses), Exponents, Division, Multiplication, Addition, and 
Subtraction. Note that: 

• Division and multiplication have equal precedence, calculated from left to right.  
• Addition and subtraction have equal precedence, calculated from left to right.  

 

Types of References 

Relative References 

In the last lesson, we learned that worksheets are composed of rows (horizontal, referenced 
with numbers) and columns (vertical, referenced with letters). The intersection of each row 
with a column forms a cell, and each cell is given a name in the “ColumnRow” format. These 
are called relative references and are typically the most commonly used type of reference 
in Excel. Such references are flexible in that they change depending upon the position of the 
formula.  

Absolute References 

While relative references are fine for most situations, if data is moved around or copied 
using AutoFill, relative cell references can create incorrect and confusing results. To avoid 
this, absolute cell references are used. These references use dollar signs ($) to make sure a 
formula always references the same location, no matter where it is moved.  

You can assign absolute cell references in three ways:  
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• $Column$Row: Both the row and column designation will not change ($A$1). 

• $ColumnRow: The column designation will not change, but the row can ($A1). 

• Column$Row: The row designation will not change, but the column can (A$1). 

 

Mixed References 

Mixed references include a mix of absolute and relative cell references. For example, 
$ColumnRow ($A1) is a mixed reference because while the column designation is an 
absolute reference, the row designation is relative. Additionally, Column$Row (A$1) is also 
a mixed reference because the row designation is an absolute reference, while the column 
designation is a relative reference.  
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Activity 2-1: A Closer Look at Formulas 
Now that you know a bit more about formulas, you want to take a closer look at the 
workbook your company uses to track invoices.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 2-1 from 
OneDrive. (Refer back to Activity 1-2 and Activity 1-3 if you need help.)  

2.  First, let’s look at the Invoice Details worksheet. Click its tab to display it:  
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3.  Look at the structure of this workbook: it shows the quantity, unit price, discount, 
and total cost for each item ordered. Let’s take a closer look at how the Total is 
counted. Click cell H7 to activate it:  
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4.  This formula is very simple. It multiplies the quantity by the unit price, and 
subtracts the discount:  

 

5.  Now, let’s take a look at the Invoice worksheet. Switch to it by clicking its tab:  
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6.  Examine the formulas in cells D9 and E9. You can see that these are very complex 
functions that look up and summarize information from the Invoice Details sheet:  

 

7.  Now, click cell G9. This formula is easy to understand – it uses the results of those 
complex calculations to calculate the total price:  
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8.  Scroll down in the workbook and click cell G28:  

 

9.  This is another simple formula that uses parentheses to control the order of 
calculations, so that any deposit is subtracted after the total with tax is calculated:  
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10.  Close the Excel browser tab to complete this activity.  

  



Microsoft 365 Excel: Online 

 

73 

TOPIC B: Using Formulas and Functions 
 

Functions are the next step in our examination of Excel. The purpose of a function is to 
provide you with an easy way to perform a complex calculation, so that you can focus on 
results instead of trying to remember your grade-school math equations. In this topic, you 
will explore how to make the best of the functions provided in Excel.  

 

Topic Objectives 

In this session, you will learn: 

• About functions 

• About formula AutoComplete 

• How to use the Insert Function dialog box 

• How to use AutoSum 

• How to view quick calculations in the status bar 

• About automatic workbook calculations 
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About Functions 

Functions are pre-made operations that are used to perform calculations. Excel features a 
number of functions relating to basic math, financial applications, logic, date and time, and 
more. Arguments define the data to calculate. Together, functions and arguments comprise 
a formula. 

For example, if you want to add a column of 10 numbers, you could type =A1+A2+A3+…etc., 
but that would quickly become tedious and would also make the spreadsheet harder to 
work with. A much more efficient way of performing this calculation is to use the SUM 
function, followed by the range of cells you want to add: 

 

This is much easier than typing out a very long formula and allows for more flexibility if 
additional rows are added within the range.  
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Creating a Function with AutoComplete 

As you are typing into the formula bar, Excel will suggest functions and show a description 
of the top result:  

 

You can use your arrow keys to select the desired function and press Tab to apply it, or 
continue typing and ignore Excel’s suggestions. Once the function is entered, Excel will 
prompt you to enter each argument (data point) as necessary. For the SUM function, the 
arguments will be the values and/or cell(s) to be added: 
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Note that you can click and drag to add cell ranges to the formula:  

 

When the formula is complete, add the closing parenthesis, press Enter, and Excel will 
calculate the value:  
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Using the Insert Function Dialog Box 

In this example, we used the SUM function, which is quite easy to remember. However, you 
can also use the Insert Function dialog box to create functions. To start, click the Insert tab 
and click Function, or click the Insert Function button on the formula bar:  

 

The Insert Function dialog box will open. At the top, you can choose a category:  
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Then, choose the desired function from the list and click OK to insert it:  

 

It will now be entered into the cell and the formula bar, ready for you to complete it with 
arguments:  
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Using AutoSum 

You can also insert common formulas using the AutoSum command on the Home tab. First, 
click the cell immediately below (if summing a column of data) or to the immediate right (if 
summing a row of data) of the data you want to calculate. Then, click the AutoSum 
command to use that function, or click the drop-down arrow to choose a different one:  

 

When you click AutoSum, the function and the arguments will be inserted based on the 
surrounding data. As well, the column or row of data to be summed will be highlighted:  
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Press Enter to complete the formula:  

Here is an overview of the functions available in the AutoSum menu.  

Name Description 

Sum Add values in a specified range.  

Average Determine the average value in a range.  

Count Numbers Determine the number of cells that contain a numeric value in a 
range.  

Max Find the highest value in a range.  

Min  Find the lowest value in a range.  
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Viewing AutoSum Calculations in the Status Bar 

When you select a range of data, Excel will automatically calculate the average, count, and 
sum of the data and display it in the status bar:  

 

To view additional automatic calculations, click the dropdown arrow next to the right-most 
calculation:  

 

You will then see the results of all the available automatic calculations. You can click any 
entry to add it to the status bar (or remove it, if it is already present.)  
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Automatic Workbook Calculations 

By default, Excel will automatically calculate formula results. However, this process can be 
delayed depending on the size of the workbook. To force Excel to calculate the workbook, 
click Formula  Calculate Workbook:  

 

The calculations will then be completed.  
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Activity 2-2: Using Formulas and Functions 
In this activity, you will start working on a rough draft of a sales report.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 2-2 from 
OneDrive.  

2.  First, we need to set up formulas to calculate the operating profit. Click cell F2:  

 

3.  Type an equals (=) sign. Then, click cell D2:  
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4.  Type a minus (-) sign and click cell E2:  

 

5.  Press Enter to complete the formula:  
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6.  We will complete the rest of the column in the next activity. For now, click cell H2 
and repeat Steps 2 through 5 to create a formula that subtracts depreciation from 
the operating profit, to calculate the net profit:  

 

7.  Now, let’s work on our scorecard. Click cell L2, where we want to calculate the 
average revenue:  

 

8.  Click the AutoSum arrow on the Home tab and click Average:  
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9.  By default, Excel will select the values in the first part of the row, but this is not 
what we want. Click and drag to select cells D2 to D20 instead:  

 

10.  Press Enter to complete the formula and calculate the results:  

 

11.  Cell L3 should now be selected. This is where we want to display the highest 
revenue. Let’s use a different method to create this formula. To begin, click Insert 
 Function:  
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12.  Ensure that the Commonly Used category is selected. Then, click the MAX function 
from the list. Click OK to insert it: 

 

13.  Now, click and drag to select cells D2 to D20:  
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14.  Press Enter to complete the formula and calculate the results:  

 

15.  Now, use either the AutoSum command or the Insert Function command to 
calculate the lowest value in the Operating Expenses column with the MIN 
function:  
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16.  Let’s double-check the first two values we calculated. Select cells D2 to D20:  

 

17.  Look at the average calculated in the status bar, and compare it to the average 
calculated using the function:  
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18.  However, the MAX function is not shown here. Click the dropdown arrow next to 
the SUM calculation on the status bar:  

 

19.  The Max value shown here should match our MAX function:  

 

20.  Close the Excel browser tab to complete this activity.  
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TOPIC C: Working with Data 
Excel contains a number of tools to help reduce your workload and streamline tasks. This 
topic will introduce you to a few tools and techniques that you can use when working with 
formulas.  

 

Topic Objectives 

In this session, you will learn how to: 

• Select cells 

• Cut, copy, and paste data 

• Use paste options 

• Move data with drag and drop 

• Use Undo and Redo 

• Use AutoFill and Flash Fill 
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Selecting Cells 

Below are some of the more common techniques that you can use to select various parts of 
a worksheet:  

Select a cell Click on the cell.  

Select a contiguous range of cells Click the first cell included in the range. 
Hold down the Shift key and then click on 
the last cell in the range.  

Select an entire row Click on the numerical header.  

Select an entire column Click on the alphabetic header.  

Select an entire worksheet Click the worksheet selector next to 
Column A ( ) or press Ctrl + A on your 
keyboard.  
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The Cut, Copy, and Paste Commands 

Just like many applications, Excel allows you to move and/or copy cells and their contents to 
other areas of the workbook or even other applications. You can move a cell’s contents 
using the Cut and Paste commands. To copy a cell’s contents, use the Copy and Paste 
commands.  

You can find all of these commands in the Clipboard group of the Home tab:  
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These commands are also available on the right-click menu:  

 

 

Keyboard Shortcuts 

Here are the keyboard shortcuts for these commands.  

• Cut: Ctrl + X 

• Copy: Ctrl + C 

• Paste: Ctrl + V 
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Using Paste Options 

Special paste options are available under the Paste command by clicking the dropdown 
arrow:  

 

The standard Paste option (at the top and available by clicking directly on the Paste button) 
is used to paste all formatting with the contents of the cell. You can also choose to paste 
only the formulas, values, or formatting by selecting one of those options from the menu.  
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Moving Data with Drag and Drop 

You can also move Excel data by selecting cell(s) and dragging and dropping them to a new 
location:  
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The Undo and Redo Commands 

Like many other applications, the Undo command allows you to reverse the last action that 
you completed. The Redo command, on the other hand, will repeat the last action. Both of 
these commands are available on the Home tab:  

 

You can also perform the Undo command by pressing Ctrl + Z on your keyboard. The 
shortcut for the Redo command is Ctrl + Y.  
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Using AutoFill 

AutoFill can help you quickly enter repeated or incremental text and numbers. For example, 
imagine that you have to enter all of the years from 2010 to 2020 in a worksheet. Rather 
than typing each year manually, you can use AutoFill to enter the data quickly and easily.  

In order to use AutoFill, you need to establish a pattern. For this example, we will type 2010 
in one cell and 2011 immediately below. Then we will select both cells: 

 

Next, we will click and drag the AutoFill handle (the small green square in the bottom right 
corner of cell A2) down the worksheet until the desired value is reached. In this case, we 
know there are 11 numbers in our desired range: 
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When you release the mouse button, Excel will automatically fill in the values:  

 

Excel also comes pre-programmed with some other common AutoFill sequences, including 
days of the week and months of the year.  
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Using Flash Fill 

Flash Fill is similar to AutoFill, but automatically extracts or combines data. Let’s look at this 
worksheet as an example:  

 

We know that each person’s email address is their first initial with their last name, at the 
domain “acmewidgets.com.” We have filled in the first email address as an example, but it 
would be quite time-consuming to manually enter each one. 
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Instead, let’s select the column and click Data  Flash Fill:  
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Here are the results:  
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Activity 2-3: Working with Data 
In this activity, you will use AutoFill and Flash Fill to complete the financial data workbook.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 2-3 from 
OneDrive.  

2.  First, let’s use AutoFill to complete the formulas for the two profit columns. First, 
select cell F2 and place your cursor over the green handle in the bottom right 
corner of the cell:  
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3.  Click and drag it down to cell F20. This will copy the formula from F2 to all of the 
blank cells, adjusting the references for each row:  

 

4.  Observe the results:  
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5.  Repeat this process with column H:  

 

6.  Now, let’s use Flash Fill to separate the State abbreviations in Column A into 
Column B. Click in cell B2 and type “NH” as this is the state abbreviation referenced 
in A2:  
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7.  Select Column B by clicking the column header:  

 

8.  Click Data  Flash Fill:  
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9.  Observe the results:  

 

10.  Close the Excel browser tab to complete this activity.  
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TOPIC D: Working with Rows and Columns 
The next level of working with data in Excel is modifying entire rows and columns. In this 
topic, we will learn about inserting, deleting, resizing, hiding, and showing rows and 
columns. We will also discuss the Clear feature, which allows you to clear contents and/or 
formatting from cells.  

 

Topic Objectives 

In this session, you will learn how to: 

• Insert, delete, resize, hide, and unhide rows and columns 

• Clear contents and formatting from cells 
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Inserting Rows and Columns 

To insert a new column, click the column to the left of where you want the new column to 
appear. Or, to insert a new row, click the row above where you want the new one to 
appear. Then, click Home → Insert and choose what to insert: 

 

(Notice that you can also insert individual cells from this menu.)  

You can also access these options from the right-click menu: 
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Deleting Rows and Columns 

Deleting rows and columns works in the same way, with commands available on the Home 
tab and right-click menu:  
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Clearing Data from Cells 

If you just want to clear the data from cells (rather than deleting the cell itself), you can do 
so by clicking Home  Clear  [object type]:  

 

Alternatively, you can clear all of these objects at once by clicking Home  Clear  Clear 
All. As well, there is a Clear Contents command on the right-click menu.  

 

Changing Column Width and Row Height 

Sometimes it will be necessary to change the size of a row or column in order to display all 
the data in the cell. You also might want to change the size of a row or column just for 
appearance. In either case, resizing a row or column is quite easy. 

To change the size of a column, place your mouse pointer on the line that divides the 
column headers. (For example, if you wanted to change the size of column C, you would 
place your mouse pointer on the line separating C and D.) Your cursor will turn into a 
vertical line with a small arrow on either side. When you see this pointer, click and hold the 
left mouse button to drag the column edge to the left or right. As you drag, you will see the 
size in pixels: 
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When you release your mouse, the size of the column will be changed. To change the size of 
a row, place your pointer on the line separating the row headers and then click and drag up 
or down to make the row larger or smaller:  

 

There are more resizing commands available by clicking Home  Format:  

 

The two Auto Fit commands will automatically size the row or column to their contents. The 
Row Height and Column Width commands will open a dialog box where you can enter the 
desired dimensions:  
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The Hide and Unhide Options 

Excel also gives you the ability to temporarily hide particular rows and/or columns and then 
unhide them when necessary. To begin, select the row or column that you want to hide. 
Then, click Home → Format → Hide & Unhide, and choose the desired option:  
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In this example, Column B is hidden:  
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To reshow it, we would reselect the surrounding columns and click Home  Format  
Hide and Unhide  Unhide Columns:  

 

The column would then reappear as normal.  
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Activity 2-4:  Working with Rows and Columns 
In this activity, you will polish the appearance of your sales report.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 2-4 from 
OneDrive.  

2.  The Financial Scorecard worksheet should be open. (If not, click its tab to switch to 
it.) You can see that Column A overlaps Column B, which is actually blank. Double-
click the separator between these two columns to automatically resize Column A:  
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3.  Now, right-click the Column B header and click Delete Columns:  
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4.  The scorecard should look like this:  
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5.  Now, switch to the Financial Data worksheet:  
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6.  The scorecard data is duplicated on this sheet, so let’s remove it. Select cells J1 to 
L4:  

 

7.  Click Home  Clear dropdown arow  Clear All:  
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8.  The data will now be removed. Finally, let’s resize this sheet’s columns. Since we 
have many columns to resize, we will use a slightly different method. Click the 
selector icon in the top left corner of the data to select the entire worksheet:  

 

9.  Click Format  Auto Fit Column Width:  
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10.  Review the results:  

 

11.  Close the Excel browser tab to complete this activity.  
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TOPIC E: Sorting and Filtering Data 
Excel’s sort and filter commands allow you to change the display of data, or refine the data 
shown. In this topic, you will learn about the differences between the two commands and 
how to use each feature.  

 

Topic Objectives 

In this session, you will learn how to: 

• Describe the differences between sorting and filtering 

• Sort data 

• Enable filtering 

• Use the Filter dialog box and text filters 

• Clear a filter 
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The Difference Between Sorting and Filtering 

Sorting allows you to change the order of data; text-based and numerical data can be 
sorted in ascending or descending order. It is important to keep in mind that when you sort 
data you are not changing the data in the worksheet; you are only changing how it is 
displayed. Additionally, while there is no option to clear a sort and return it back to its 
original state, the Undo command has the same effect. Finally, if you apply a sort and then 
save your workbook, the sort will also be saved. This means that if you need to undo a sort, 
you can only do it in the same session as when the sort was applied. 

Filtering is a bit different; it allows you to customize data that is displayed, based on criteria 
of your choosing. For example, if you only wanted to show sales results from 
representatives in the Northern region, you could use a filter to do that.  

 

Sorting Data 

In this example, we would like to arrange the data in alphabetical order by the Region 
column. Right now, it is in random order:  
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To do this, we will select the column header (cell C1) and click Home  Sort & Filter. We 
can now choose an ascending or descending sort:  

 

For this example, we chose an ascending (A to Z) sort. Here are the results:  
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Enabling Filtering 

To enable filtering, click Home  Sort and Filter  Filter:  

 

This will add AutoFiller dropdown arrows to the top of each column. Click the arrow for the 
column you want to filter:  
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This dialog box will populate with all of the values from the selected column. Uncheck a set 
of values to hide it, or check it to show it. Or, you can choose to create a text filter. When 
you are finished, click APPLY to apply your settings: 
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The data will then be filtered. Notice the icon on the Region AutoFilter menu which 
indicates the data has been filtered by this column:  
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Using Text Filters 

Next, let’s explore the Text Filters sub-menu:  

 

Clicking each of the commands in this sub-menu will open the Custom Filter dialog box pre-
populated with the selected operator. (The Custom Filter command itself will open a blank 
dialog box.) You can then enter the criteria required. 

For this example, let’s choose “contains” from the Text Filters menu. The Custom Filter 
dialog box will open: 
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Notice that we can still click the first drop-down menu to choose a different operator other 
than “contains.” However, since this is the correct operator, we will just type “Asia” into the 
text field (since that is the region we want to view) and click OK to create the filter: 

 

The results will be shown:  
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Clearing a Filter 

There are two ways to clear a filter and display all the data once again. You can click the 
AutoFilter arrow and click Clear Filter from <field name>:  
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Or, place your cursor in the filtered column and click Home  Sort & Filter  Clear:  

 

With either command, the filter will be cleared, and all data will be displayed.  
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Activity 2-5:  Sorting and Filtering Data 

You have been asked to present the sales report data by state and to exclude all corporate 
information. You will use Excel Online’s sorting and filtering tools to accomplish these tasks.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 2-5 from 
OneDrive.  

2.  Our first task is to sort the data by state. Select cells B2 to B20:  
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3.  Now, click Home  Sort & Filter  Sort Ascending:  

 

4.  A message will appear asking whether you would like to expand your selection. 
Click Expand and sort to apply the change to the entire worksheet:  
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5.  Review the results:  

 

6.  Now we want to filter out the corporate data. Press Ctrl + A on your keyboard to 
elect the entire worksheet. Then, click Home  Sort & Filter  Filter:  
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7.  Click a blank cell to deactivate the selection. Then, click the dropdown arrow in cell 
C1 (Office Type):  

 

8.  Uncheck the box for Corporate and click APPLY:  
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9.  Review the results, and note the AutoFilter icon in cell C1:  

 

10.  Close the Excel browser tab to complete this activity.  
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Summary 
This lesson introduced you to many different aspects of working with data. We started out 
with a look at formulas and functions. We then looked at working with data as a whole and 
managing rows and columns. Finally, we learned how to customize data display with sort 
and filter. 

 

Review Questions 
1. List one way to open the Insert Function dialog box.  

 

2. How do you enable filtering?  

 

3. How is Flash Fill different from AutoFill?  

 

4. In this equation, which operation will be evaluated first ? (5*10)+40/3 

 

5. What is the easiest way to completely clear a cell using the ribbon interface?  
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LESSON 3: 
FORMATTING A WORKSHEET 

 

Lesson Objectives 

In this lesson you will learn how to: 

• Format text and cells 

• Align cell contents 

• Use Find and Select tools 

• Apply conditional formatting 
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TOPIC A: Formatting Text 
Excel contains many of the text formatting tools that you might be familiar with from other 
Microsoft Office applications, such as Word or PowerPoint. In this topic, we will learn about 
different font options, as well as how to use the Format Painter and create hyperlinks. 

 

Topic Objectives 

In this session, you will learn: 

• About fonts and the Font group on the Home tab 

• How to use the Format Painter 

• How to create hyperlinks 
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What is a Font?  

A font is a complete set of characters (with typeface and style) that are used to create text. 
Fonts are very customizable: you can change their size, type, and color to create just the 
effect you are looking for. Note, however, that you will have fewer font faces and 
formatting options in Excel Online than the desktop application. 

Here is a sample of a few different fonts: 
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The Font Group 

Naturally, the Font group of the Home tab is where you will find most font commands. You 
can choose the font face, size, color, and effects here:  

 

The top row of this group contains commands to:  

• Change the font face 
• Change the font size 
• Nudge the font size up or down 

The bottom row of this group contains commands to:  

• Apply bold, italic, underline, double underline, and strikethrough effects 
• Format cell borders 
• Add shading to cells 

• Change the font color 
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The Format Painter 

With the Format Painter, you can copy just the formatting from one cell and apply it to 
others in your worksheet. To use the Format Painter, select a cell and then click Home → 
Format Painter:  

 

The cell that you selected will be identified with a scrolling dashed border and your mouse 
pointer will now have a paintbrush beside it. Now, any cell or range you select will assume 
the formatting of the cell that you selected:  
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Here are the results of this example:  

 

The Format Painter will then automatically turn off. You can also click the command again 
or press Esc to cancel the process while the Format Painter is activated. 

 

Creating Links 

To create a hyperlink, select the text or object to which you want to add the link. Then, click 
the Hyperlink command on the Insert tab or right-click menu: 
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With either method, the Insert Hyperlink dialog box will open:  

 

At the top of this dialog box, you can change the text displayed in the cell containing the 
link. Then, use the radio buttons at the bottom of the dialog box to choose whether you 
want to link to a URL, place within the workbook, or use an email address. Finally, enter the 
related information in the selected field.  

Here, we have linked to the URL “http://www.microsoft.com”. Click OK to create the link:  

 

 

http://www.microsoft.com/
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Your changes will be applied. You can follow the link by clicking the cell:  

 

To modify the hyperlink, perform the Insert Hyperlink command again. To remove it, use 
the Clear command on the Home tab.  
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Activity 3-1:  Formatting Text 
In this activity, you will format header rows and a title in your worksheet.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 3-1 from 
OneDrive. (Refer back to Activity 1-2 and Activity 1-3 if you need help.)  

2.  First, let’s format the header row of the Financial Data sheet. Select Row 1:  

 

3.  Click the Grow Font button twice:  
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4.  The value in the Size menu should now be 14:  

 

5.  Apply the Bold effect:  

 

6.  Click the dropdown arrow next to the Font Color command:  
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7.  Click the swatch for Blue-Gray, Text 2:  

 

8.  Because of the font changes, the data no longer fits in the cells. Press Ctrl + A to 
select the entire worksheet. Click Home  Format  Auto Fit Column Width:  
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9.  Now, let’s copy the header row formatting to the second sheet. Click any cell in 
Row 1 to select it and click Home  Format Painter:  

 

10.  Click the Financial Scorecard worksheet tab:  

 

11.  Click cell A1:  
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12.  The formatting will be applied:  
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TOPIC B: Formatting Cells 
Like working with fonts, you can also modify the appearance of cells in a variety of ways. For 
example, you can change the border options, fill colors, and even the format of data.  

 

Topic Objectives 

In this session, you will learn how to: 

• Apply borders and fills to cells 

• Change and customize number formats 
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Applying a Border 

To add a border, select a range of data, click the arrow next to the Home  Borders button, 
and choose what type of border you wish to apply to the range:  

 

Note that there is also a No Border option, which will remove an applied border.  
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The formatting will be applied, and the selected option will now be available by clicking the 
Border command directly. For example, here we applied thick outside borders to the cell, so 
this option is now reflected on the Border icon:  
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Applying a Fill 

To apply a fill color, select the range of cells that you want to modify. Then, click Home  
Fill Color arrow and click the desired color:  

 

Just like the Borders command, the Fill command will show the most recently applied color. 
Click the icon directly to apply it.:  

 



Microsoft 365 Excel: Online 

 

156 

Changing the Number Format 

Number formats are used to change the appearance of data and improve its readability. 
You can find the related commands in the Number group of the Home tab:  

 

Listed below are the commands and actions in this group:   

1. Click the dropdown menu to choose a number format.  
2. Click this icon to open a dropdown menu with various accounting formats.  
3. Click this icon to apply the Percentage number format.  
4. Click this icon to apply the Accounting Comma number format.  
5. Click these icons to increase or decrease the decimal position.  

 

Formatted Numbers and Cell Width 

One thing to watch out for when formatting numbers is that the cell width can sometimes 
not provide enough room for the data and its formatting. This will cause Excel to display a 
series of # symbols in place of the actual data:  

 

This problem can be solved by adjusting the column width or by choosing another number 
format.  
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Customizing Number Formats 

You can also create a custom number format. To begin, select the cell or cells that contain 
numbers you want to format. Then, open the Number Format dropdown under the Home 
tab, and click More Number Formats:  
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The Number Format dialog box will open:  

 

You can use this dialog box in two ways. You can choose a category from the left and use 
the options in the center of the dialog box to modify that number format:  
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Or, create a custom format using one of the last two categories. The Special category allows 
you to select custom number formats based on location, while the Custom category 
contains miscellaneous formatting options: 
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Activity 3-2:  Formatting Cells 

In this activity, we will add number formatting and borders to our financial data report.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 3-2 from 
OneDrive.  

2.  First, let’s apply the proper formatting to our data. The Financial Scorecard 
worksheet should be open. (If not, click its tab to switch to it.) Select the three cells 
containing numbers in Column B:  
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3.  Click the dollar ($) icon in the Number group of the Home tab and click $ English 
(United States):  

 

4.  The formatting will be applied. However, we do not need the cents information, so 
click Decrease Decimal twice:  
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5.  This will remove the decimals from the numbers, but notice that the full value is 
still available in the formula bar:  

 

6.  Now, switch to the Financial Data worksheet:  

 

7.  Select cells D3 through H20:  
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8.  Click the dollar ($) icon in the Number group of the Home tab and click $ English 
(United States):  

 

9.  Click the Decrease Decimal button twice to remove the cents values:  
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10.  Review the results:  

 

11.  Finally, let’s make the header row stand out a bit more. Select cells A1 to H1:  
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12.  Click the Borders dropdown arrow and click Thick Bottom Border:  

 

13.  The border will be added. Now, click the Fill dropdown arrow and choose Gray, 
Accent 3, Lighter 80%:   

 

(If this color is not shown, select another color with a light shade.) 
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14.  Click any cell to de-select the header row. Review your formatting changes:  

 

15.  Close the Excel browser tab to complete this activity.  
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TOPIC C: Aligning Cell Content 
Alignment tools are another way to make your worksheet more attractive and readable. 
This topic will introduce you to a few key tools, including alignment, text wrapping, and cell 
merging.  

 

Topic Objectives 

In this session, you will learn how to: 

• Set alignment options 

• Use indent commands 

• Wrap text 

• Use Merge & Center 
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Alignment Options 

To align data within a worksheet, select the cell(s) you want to adjust and then use the 
commands in the Alignment group of the Home tab:  

 

The top row of options controls vertical alignment, while the bottom row controls 
horizontal alignment.  

 
The Indent Commands 

The Indent commands in the Alignment group of the Home tab allow you to adjust the 
space between a cell border and its contents:  

 

For example, if the contents of a cell are left-aligned, clicking Increase Indent (right arrow) 
will increase the space between the contents and the left border. Similarly, clicking 
Decrease Indent (left arrow) will decrease that space.  
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The Wrap Text Command 

When you enter text into a cell and that text exceeds its dimensions, the contents will 
continue and overlap to the next cell if it contains no data. If the neighboring cell does 
contain data, the content will be truncated and hidden (although the full text will be 
displayed in the formula bar):  

 

 
Clicking Home  Wrap Text with the cell selected will adjust the row height to 
accommodate overlapping text:  
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(Wrap Text can be toggled off by clicking Home  Wrap Text again.)  

 

 

Manual Line Breaks 

You can achieve the same effect using manual line breaks. To add a manual line break to a 
cell, press Alt + Enter at the desired break location when editing the contents.  

 

Merge & Center Options 

Occasionally, you may need a long cell for a heading, or you may need to resize columns or 
rows so that long items can be displayed. The Merge & Center options allow you to select a 
group of cells, either across a row or down a column, and combine them to form one large 
cell.  
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To do this, select a group of adjacent cells and click Home → Merge & Center:  

 

Here are the results:  
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Note that you can access a few more options from the Merge & Center dropdown menu:  
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Activity 3-3:  Aligning Cell Content 

In this activity, you will use alignment tools to improve the appearance of your financial 
data worksheet.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 3-3 from 
OneDrive.  

2.  Select Row 1:  

 

3.  Click Home  Align Center:  
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4.  The formatting will be applied. Now, notice how the dollar sign is separated from 
the numerical data. Let’s fix this by modifying the indent. Select cells D2 through 
H20:  

 

5.  Now, click Home  Increase Indent:  
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6.  The formatting will be applied. Switch to the Financial Scorecard tab:  

 

7.  Select the data in cells B2 to B4. Use the Increase Indent command to fix this data 
display:  

 

8.  Now, let’s reapply the Merge and Center formatting to the title. Select cells A1 and 
B1:  
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9.  Click the Merge & Center dropdown arrow under the Home tab:  

 

10.  Review the options. It looks like the Merge & Center command is fine for our 
needs. Click this option to apply it:  

 

11.  Close the Excel browser tab to complete this activity.  
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TOPIC D: Using Find & Select Tools 
Excel offers a number of tools to help you find, replace, and navigate to data within a 
workbook. This topic will cover all of these tools and give you an opportunity to practice 
using them. 

 

Topic Objectives 

In this session, you will learn how to: 

• Use the Find, Replace, and Go To commands 
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The Find Command 

To search for data in a workbook, click Home  Find & Select  Find, or press Ctrl + F:  

 

With either command, the Find dialog box will open:  

 

You can type your search term in the Find what field:  
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Clicking Search Options will display additional menus and options:  

 

Here is an overview of the Search Options.  

• Use the Within menu to choose whether you want to search within the current 
selection, worksheet, or workbook.  

• The Direction menu allows you to control which direction the search starts in.  
• The checkboxes allow you to require an exact case match and/or a match to the full 

cell contents.  

Once you have set your options, click Find Next to see the first result:  

 

You can continue clicking Find Next to view additional results. You can also work with Excel 
data even while the Find dialog box is open.  
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The Replace Command 

To replace search terms with something else, you can:  

• Click the Replace command in the Find dialog box 
• Click Home  Find & Select  Replace 

• Use the Ctrl + H shortcut 

With any of these actions, the Find and Replace dialog box will open:  

 

The Find and Replace dialog box is very similar to the Find dialog box, except there is also a 
field to enter replacement text for the search term(s). You can then click Replace to view 
each match and replace it, or click Replace All to replace search terms automatically.  
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You can view additional search options by clicking Search Options:  

 

 

The Go To Command 

The final command in the Find & Select menu is Go To:  

 

(You can also use the Ctrl + G shortcut.)  
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The Go To dialog box will open:  

 

Enter the cell range you want to navigate to and select which sheet you want to search. 
Then click OK.  
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Activity 3-4:  Using Find & Select Tools 

You have been asked to confirm that the data for the Spring City office is included, and to 
make a terminology change in the financial data report.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 3-4 from 
OneDrive.  

2.  First, let’s check for the Spring City data. Click Home  Find & Select  Find:  

 

3.  The Find dialog box will open. Type, “Spring City” in the Find what field:  

 

4.  Open the Search Options dropdown:  
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5.  Open the Within dropdown menu, and make sure Workbook is selected: 

 

6.  Click Find Next:  
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7.  Excel will now switch to the Financial Data sheet and select the match:  

 

8.  Now we need to make the terminology change. With the Find dialog box still open, 
click to select Column C:  
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9.  Click the Replace button:  

 

10.  Now, fill out the dialog box with the following information:  

• Find what: “Partner” 
• Replace with: “Co-Owned” 

Click the Search Options Dropdown and make sure Selection is chosen 

• Within: Selection 
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11.  Once this information has been entered, click Replace All:  

 

12.  When the replacements are complete, close the Find and Replace dialog box:  

 

13.  Close the Excel browser tab to complete this activity.  
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TOPIC E: Applying Conditional Formatting 
While Excel workbooks and worksheets can contain all sorts of important data, sometimes 
that data can be lost in a sea of information. Excel’s conditional formatting feature can help 
bring attention to patterns or outliers in your data. 

 

Topic Objectives 

In this session, you will learn: 

• About conditional formatting 

• How to apply, customize, and clear conditional formatting 
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What is Conditional Formatting?  

Conditional formatting will automatically highlight cells with data that satisfies certain 
criteria. It is useful for worksheets that show financial figures (where black formatting might 
equal positive values, while red formatting might equal negative values), test results (where 
results change color based on their value), or any time you want to highlight data within a 
certain range.  

 
Applying Conditional Formatting Rules 

To apply conditional formatting, select the target data, click Home  Conditional 
Formatting, choose the formatting category, and choose a style:  
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Here is an overview of the categories.  

• Highlight Cells Rules: Highlights cells that are greater than, less than, between, or 
equal to specified values.  

• Top/Bottom Rules: Highlights the top or bottom numbers or percentages in the 
selected cells.  

• Data Bars: Displays colored bars that are indicative of the value in the cell. (The 
more the cell is filled in, the higher its value compared to the other cells in the 
range.)  

• Color Scales: Uses different shades of color to represent different values, from low 
to high.  

• Icon Sets: Applies graphics to usually indicate a cell’s value.  

Here, we have added an icon set to our data:  
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Setting Conditional Formatting Options 

The options in the top two categories in the Conditional Formatting menu (Highlight Cells 
Rules and Top/Bottom Rules) require you to set advanced options before they can be 
applied. Let’s use the Less Than style as an example:  

 

The Conditional Formatting sidebar menu will open:  
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Most of the fields will be pre-populated. In the fourth field under the Rule Type heading, 
enter the value we want to look for. In this example, we want to select values less than 
$250,000:  
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Then, under the Format with heading, we can choose the formatting we want to use. In this 
example, we want values less than $250,000 to be formatted with red text:  
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Then click Done:  

 

Here are the results:  
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Clearing Conditional Formatting 

To remove conditional formatting rules, click Home  Conditional Formatting  Clear 
Rules, and choose what you want to clear:  

 

All conditional formatting rules will then be removed.  
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Activity 3-5:  Applying Conditional Formatting 

You have some ideas on how conditional formatting can make your financial data easier to 
interpret. In this activity, you will experiment with a few different types of conditional 
formatting rules. 

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 3-5 from 
OneDrive.  

2.  First, we want to identify revenues under $250,000. Select the Revenues column:  

 

3.  Click Conditional Formatting  Highlight Cells Rules  Less Than:  
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4.  The Conditional Formatting sidebar menu will open. Type “250000” in the fourth 
field under the Rule Type heading, leave the formatting set at the default setting, 
and click Done:  

 

5.  The formatting will be applied. Close the Conditional Formatting sidebar menu:  
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6.  Now let’s add an icon set to the Net Profit column. Select the column:  

 

7.  Click Home  Conditional Formatting  Icon Sets  3 Symbols (circled):  
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8.  Review the results:  

 

9.  The red formatting applied to the empty section of Column D now looks a bit 
strange. Click cell D21 and press Ctrl + Shift + ↓ on your keyboard to select it and 
all cells below it. Then, click Home  Conditional Formatting  Clear Rules  
Clear Rules from Selected Cells:  
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10.  The formatting will now be cleaned up:  

 

11.  Close the Excel browser tab to complete this activity.  
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Summary 
In this lesson, you learned how to format different aspects of a worksheet. You should feel 
comfortable formatting data using fonts, borders, fills, number formats, and alignment 
tools. You should also feel comfortable applying conditional formatting and locating data 
using the Find & Select menu. 

 

Review Questions 
1. What does the Format Painter do?  

 

2. Formulas always start with what symbol?  

 

3. When you select a range of data, where are automatic calculations displayed?  

 

4. What commands are available on the Home  Merge & Center dropdown menu?  

 

5. True or False: Cell references are case-sensitive.  
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LESSON 4: 
ADDING PICTURES AND SHAPES 

 

Lesson Objectives 

In this lesson you will learn how to: 

• Insert pictures and shapes 

• Format shapes 
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TOPIC A: Inserting Pictures 
Like many other Microsoft Office programs, Excel allows you to add pictures to its 
worksheets. Some basic editing commands are also provided.  

 

Topic Objectives 

In this session, you will learn how to: 

• Insert, rotate, resize, and delete pictures 

• Add alternative text to pictures 
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Inserting Pictures 

To insert a picture from a file on your computer, select the cell where you want the picture 
to go. Then, click Insert  Picture:  

 

You will then be prompted to locate and choose the file. Click Open when you are ready:  
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The picture will then be added to the current worksheet:  

 

 

Resizing Pictures 

To resize a picture, click it to select it. Then, click and drag any of the handles to resize the 
photo in that direction. As you drag the handles, you will see the photo become larger or 
smaller, depending on the direction that you drag in:  

 

Once you release your mouse, the operation will be complete.  
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Rotating Pictures 

To rotate a picture, click and drag the circular handle at the top of the picture:  

 

Release the mouse when the picture is at the desired angle.  

 

Deleting Pictures 

To delete a picture, click it to select it and press the Backspace key. The picture will 
immediately be removed.  
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Adding Alternative Text 

Alternative text refers to text that is assigned to an object so that it can be used by screen 
readers to describe a picture to users with visual impairments. To add alternative text to a 
picture, right-click it and click Alt Text:  
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The Alternative Text dialog box will open:  

 

Enter the picture’s title and description and then click OK to apply it.  
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Activity 4-1:  Inserting Pictures 

In this activity, you will add a picture to the financial data report.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 4-1 from 
OneDrive. (Refer back to Activity 1-2 and Activity 1-3 if you need help.)  

2.  Ensure the Financial Scorecard worksheet is active and select cell D1:  
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3.  Now you want to insert an image. To insert an image in Excel Online, it must be 
downloaded onto your computer. So first, you need to download the sample image 
from OneDrive to your computer. Navigate back to OneDrive, and click the 
checkbox next to Activity 4.1.png to select it:  

 

4.  Click Download:  
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5.  Return to Activity 4-1 in Excel Online and ensure cell D1 is still selected. Click Insert 
 Picture: 

 

6.  The image we just downloaded should appear in your Downloads folder, or 
whichever folder you have selected as the default for downloads. Navigate to this 
folder, select the Activity 4-1 image, and click Open:  

 



Microsoft 365 Excel: Online 

 

212 

7.  The picture will now be inserted. Click and drag the bottom right corner up to cell 
D4, like this:  

 

8.  Now, let’s add alternative text to the picture. Right-click it and click Alt Text:  
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9.  The Alternative Text dialog box will open. Enter “Report Icon” for the title and 
“Blue report graphic with chart and text placeholders” for the description. Click 
OK:  

 

10.  Close the Excel browser tab to complete this activity.  
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TOPIC B: Inserting Shapes 
Excel also allows you to insert shapes into a workbook. If you have worked with shapes in 
other Microsoft Office programs, these commands are quite similar.  

 

Topic Objectives 

In this session, you will learn how to: 

• Insert, resize, and delete shapes 

• Use the Shape contextual tab 
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Inserting Shapes 

To insert a shape into the current worksheet, click Insert  Shapes and click the shape you 
want to add:  
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The shape will now appear on the worksheet and the Shape tab will become available:  

 

 

The Shape Tab 

Let’s take a closer look at the Shape tab:  

 

There are two groups on this tab. The Edit Shapes group provides access to the Change 
Shape command. The Shape Styles group includes a gallery of pre-configured styles and 
commands to customize the shape’s fill and outline. 
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Resizing Shapes 

Resizing a shape is just like resizing a photo: click it to select it and then click and drag any of 
the handles. 

 

Once you release your cursor, the shape will be resized.  

 

Deleting Shapes 

To delete a shape, click it to select it and press the Backspace key. The shape will 
immediately be deleted, and can only be recovered if you undo the delete action right 
away.  
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Activity 4-2:  Inserting Shapes 

In this activity, you will add a shape to the financial data report.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 4-2 from 
OneDrive.  

2.  Ensure the Financial Data worksheet is active. We want to add a highlight to the 
Net Profit column. To begin, click Insert  Shapes  Rounded Rectangle:  

 

3.  The shape will be inserted. Click and drag it to move it to the top of Column H:  
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4.  Now, click and drag the bottom right handle down and to the right so it covers all 
of Column H, like this:  

 

5.  The Shape tab should be active. Take a moment to review its commands:  

 

6.  Close the Excel browser tab to complete this activity.  
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TOPIC C: Formatting Shapes 
This topic will continue our exploration of shapes in Excel, with a look at the formatting 
commands on the Shape contextual tab. We will also learn how to add alternative text to 
shapes.  

 

Topic Objectives 

In this session, you will learn how to: 

• Change a shape’s type 

• Apply a style to a shape 

• Customize a shape’s fill and outline 

• Add alternative text to a shape 
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Changing the Shape Type 

To change the type of shape, click the shape to select it. Then, click Shape → Change Shape 
and choose the new shape type:  

 

The shape type will now be changed, but its size, location, and formatting will stay the 
same:  
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Applying a Style 

To apply a pre-defined style to a shape, click it to select it and then click a thumbnail from 
the Shape Styles gallery on the Shape tab:  

 

To see more options, click the dropdown arrow on the right side of the gallery:  
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Customizing Shape Fill and Outline 

The final commands on the Shape tab allows you to customize a shape’s fill and outline 
colors:  

 

Click the button to apply the color shown on the icon, or click the dropdown arrow to 
choose a different color:  
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You can also access Shape Fill and Outline options by right clicking the shape, and opening 
the menus that appear:  

 

 

Adding Alternative Text 

To add alternative text to a shape, right-click it and click Alt Text:  
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The Alternative Text dialog box will open:  

 

Enter a title and description for the shape and then click OK to apply it.   
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Activity 4-3:  Formatting Shapes 

In this activity, you will format the shape you added in the last activity.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 4-3 from 
OneDrive.  

2.  You can see a major problem with the shape we added in the last activity: it covers 
the data we want to highlight! Click it to select it:  

 

3.  Click the Shape tab to open it. Click the Fill dropdown arrow and click No Fill:  
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4.  Now we can see the data, but the highlight is not as visible as we would like it to 
be. Click the Apply Shape Styles arrow in the Shape Styles gallery on the Shape 
tab:  

 

5.  Click the Colored Outline – Orange, Accent 2 style:  
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6.  Click the Fill icon again to re-apply the No Fill style:  

 

7.  If necessary, use the handles to resize the shape so it fits the column:  

 

8.  Close the Excel browser tab to complete this activity.  
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Summary 
In this lesson, we learned all about working with pictures and shapes in a workbook, 
including inserting, resizing, and formatting them.  

 

 

Review Questions 
1. What types of pictures can you insert in an Excel Online workbook?  

 

2. Which contextual tab provides shape formatting commands?  

 

3. What does the Alt Text command for shapes and pictures do?  

 

4. How do you resize a picture?  

 

5. How do you change a shape’s type?  
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LESSON 5: 
ORGANIZING WORKSHEET DATA WITH 

TABLES AND CHARTS 

 

Lesson Objectives 

In this lesson you will learn how to: 

• Create and modify tables and charts 
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TOPIC A: Inserting Tables 
While formulas and functions are great at analyzing data within your workbook, they are 
more suited for entire workbooks rather than specific sets of data. If you need to analyze 
smaller sets of data within a large workbook or break down large sets of data into smaller 
parts, then converting your data into tables is often the best solution. Tables allow you to 
use Excel’s powerful organizational capabilities without modifying the data itself. 

 

Topic Objectives 

In this session, you will learn: 

• About tables 

• How to create and customize a table 

• How to insert and delete table rows and columns 

• How to sort and filter table data 
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What is a Table?  

A table is a specially designated range of information that has added functionality. You can 
have multiple tables per worksheet, and tables can be as large or small as the amount of 
data you want to work with. Tables can be created from existing data ranges or from empty 
ranges and then populated afterwards. As well, columns and rows may be added to a table 
just as you would when working with a normal range. Note, however, that once a table is 
created, the designation cannot be removed in Excel Online. 

There are a number of components that come together to create a table:  

 

• The Header row (1), when enabled, contains column headers and the AutoFilter 
arrow, which allows you to sort and filter table data.  

• Banded rows (2) allow you to easily differentiate between each row that appears 
within the table. This formatting feature can only be changed by manually changing 
the fill color.  

• The Total row (3), when enabled, shows a grand total for the right-most column in 
the table.  
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Creating a Table 

To create a table, select the cell range that you would like to convert and then click Home 
 Format as Table, and select a style:  

 

(This action can also be completed by clicking Insert  Table.) 

The Format as Table dialog box will open. You will see the range you selected already 
populated. Confirm it is correct, choose whether or not your table has headers, and click 
OK: 
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Here are the results:  

 

 

Customizing Row Display 

Once a table is created, you can toggle various style options, including the header row and 
total row, under the Table Design tab:  
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Inserting and Deleting Table Rows and Columns 

You can insert and delete table rows and columns just as you would in the worksheet, 
although there are special command sets for table elements.  

 Insert Rows/Columns Delete Rows/Columns 

Home tab 

 
 

Right-click 
menu 
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Sorting and Filtering Table Data 

You can sort and filter table data just like regular worksheet data using the Sort & Filter 
command on the Home tab:  
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Also, note that the AutoFilter arrow is automatically enabled, and also provides access to 
sorting and filtering options:  
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Activity 5-1:  Inserting a Table 
You have decided that because the sales report will continue to grow, it is a good idea to 
convert the range into a table.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 5-1 from 
OneDrive. (Refer back to Activity 1-2 and Activity 1-3 if you need help.)  

2.  We want to convert the values on the Financial Data tab into a table. Select cells 
A1 to H20 and click Home  Format as Table:  
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3.  Select the Blue, Table Style Medium 2 style:  

 

4.  The Create Table dialog box will open. Ensure the My table has headers box is 
checked and click OK:  
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5.  The table will now be created. Notice that the conditional formatting has stayed 
intact:  

 

6.  Now, let’s add a total row to the table. Open the Table Design tab, and click the 
Total Row checkbox:   

 



Microsoft 365 Excel: Online 

 

241 

7.  The total row will be added:  
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8.  A new set of values has been sent to us from the Augusta office in Maine. Click any 
blank cell to de-select the table. Then, right-click cell A6 and click Insert  Table 
Rows Above:  

 

9.  Fill out the cells in this new row with the following data:  

• City: Augusta 
• State: ME 
• Office Type: Corporate 
• Revenues: 248973 
• Operating Expenses: 29246 
• Depreciation: 4208 

(Do not enter any data in the two profit cells; they will automatically be calculated 
using the column’s formulas.)  
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10.  Your results should look like this:  

 

Note that the currency number format and conditional formatting rules have been 
applied automatically.  
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11.  We also want to narrow the focus of this report to only New England states. Click 
the State dropdown arrow and uncheck NJ and NY (New Jersey and New York) and 
click APPLY:  
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12.  Observe the results:  

 

13.  Close the Excel browser tab to complete this activity.  
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TOPIC B: Inserting Charts 
Charts can enhance data interpretation, make trends more obvious, and increase the visual 
appeal of your workbooks. In this topic, you will learn how to insert charts and perform 
some basic tasks with them. 

 

Topic Objectives 

In this session, you will learn: 

• About the types of charts available in Excel Online and their elements 

• About the Charts contextual tab 

• How to insert, resize, and move a chart 
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Chart Types 

When creating a chart, it is important to choose the right type for your data. Below is a list 
of each chart type that is available in Excel Online and the type of data that each is best 
suited to display: 

• Column: Used to display data changes over time or to compare separate data points. 

• Line: Typically used to display data changes over a period of time. 

• Pie: Used to compare different data points in relation to a total. For example, you 
could use this chart type to show the total expenses of a company broken down by 
department.  

• Bar: Typically, this chart type is used to compare different data points. It is similar to 
the Column chart type, but instead has the X-axis as the vertical axis and the Y-axis 
as the horizontal axis.  

• Area: This chart type is typically used to illustrate rates of change over a period of 
time, as well as including the total value in a trend.  

• X Y (Scatter): Used to illustrate values from a variety of different trends and their 
relationship to one another.  

• Waterfall: Shows the cumulative effect of a series of positive and negative values.  
• Funnel: Shows the stages in a process.  
• Hierarchical: Compares values across hierarchies. Also known as a treemap. 
• Statistical: Includes charts for specific statistical purposes, including histogram, 

Pareto, and box-and-whisker. 
• Radar: Used to compare values from multiple data sets with each separate data 

(category) on a separate axis. Typically, this chart type is best suited to identify 
outliers and commonalities between data points.  
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Chart Elements 

Each chart type has different elements that can be customized, but most charts have the 
following key elements:  

 

These items are:  

1. Vertical (Y) axis 
2. Horizontal (X) axis 
3. Gridlines 
4. Data Series 
5. Legend 
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Inserting a Chart 

To insert a chart, select the data you want to chart (including the header row). (This data 
can be organized in a table or located directly on the worksheet.) Then, click the Insert tab, 
choose the chart type, and choose the sub-type. Here, we are creating a stacked column 
chart so we can easily see each person’s sales total as well as the breakdown by quarter: 

 

(Notice that we have hidden extraneous data, so it is not included in the chart.)  
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The chart will now be inserted:  
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The Chart Contextual Tab 

When a chart is selected, the Chart contextual tab will become available on the ribbon:  

 

It includes four groups:  

• Data: Modify the chart’s data.  
• Change Chart Type: Provides the same commands as the Charts group on the Insert 

tab.  

• Labels: Change how data is presented in the chart.  
• Axes: Customize chart axes and gridlines.  
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Moving Charts 

To move a chart, click to select the chart in question and then drag it to its new destination. 
Release your mouse button to place it there:  
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Resizing Charts 

To resize a chart, click it to select it and then click and drag any of the handles:  

 

Note that although the chart may appear skewed as you do this, it will update once you 
release your cursor:  
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Activity 5-2:  Inserting Charts 

In this activity, we will add a chart to our sales report.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 5-2 from 
OneDrive.  

2.  We do not need the State or Office Type details in the chart, so select these two 
columns by clicking and dragging over the column headers:  

 

3.  Click Home  Format  Hide & Unhide  Hide Columns:  
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4.  The columns will be hidden, and we are now ready to insert our chart. Select cells 
A1 to H21:  

 

(We do not want to include the total row in our chart.)  

5.  Now, click Insert  Line  Stacked Line with Markers:  
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6.  The chart will be inserted, but it may not be in a convenient location. Click it and 
drag it so the top left edge aligns with cell J2:  

 

Make sure you scroll over to see the full chart.  

7.  There might be a better way to display this data. Let’s try changing the chart type. 
Click Chart  Column  Stacked Column:  
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8.  Do you find the new chart easier to understand?  

 

9.  Close the Excel browser tab to complete this activity.  
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TOPIC C: Modifying Charts 
In the last topic, we saw how charts can be quickly and easily added. However, you will 
often need to customize this default configuration to ensure data is displayed properly. In 
this topic, we will learn about some of those tasks. 

 

Topic Objectives 

In this session, you will learn how to: 

• Switch row and column display 

• Select which data to display in the chart 

• Change the chart type 

• Add a title to a chart 

• Modify chart labels and axes 
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Switching Row and Column Display 

Occasionally, you may find the need to transpose rows and columns so that your chart 
represents the data differently. To do this, click Chart → Switch Row/Column:  

 

The chart will now be updated:  
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Use the Select Data Command 

Once a chart has been created, you can add or remove information from the data range; 
the chart will immediately reflect those changes. To start, click Chart → Select Data:  

 

Now, the Select Data dialog box will open. Here, you can modify the data range:  

 

In this example, we only want the first quarter in the chart, so we will change the end point 
of the range and click OK:  
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The chart will now be updated:  

 

 

Changing the Chart Type 

To change the type of chart, select the chart, click the Chart tab, choose the new category, 
and choose the specific chart type. Here, we are changing a column chart into a stacked bar 
chart:  
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The results appear immediately after clicking this command:  
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Adding a Chart Title 

To add a title to a chart, click Chart  Chart Title, and choose the desired position:  

 

Note that you can choose None to turn the chart title off. To change the title of the chart, 
click Edit Chart Title. 
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The Edit Title dialog box will appear. Enter your title and click OK:  

 

The title will now be added:  

 

Remember, you can edit it by clicking Chart  Chart Title  Edit Chart Title.  
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Modifying Chart Labels 

The next four commands in the Labels group allow you to turn different elements on or off 
and control their position:  

 

For example, here are the options for positioning the legend:  
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Modifying Chart Axes 

The final group, Axes, contains two commands:  

 

The Axes command allows you to customize the display of both the horizontal and vertical 
axes:  
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The Gridlines command allows you to customize the appearance of both types of gridlines:  
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Activity 5-3:  Modifying Charts 

In this activity, we will modify the chart in our sales data report.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 5-3 from 
OneDrive.  

2.  Ensure the Financial Data worksheet is active, and the chart is selected:  

 

3.  Let’s try switching the row and column data. Click Chart  Switch Row/Column:  
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4.  Now we can see an overall picture of each of the financial data points:  

 

5.  Click Switch Row/Column again to return to the previous configuration:  
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6.  Now let’s add a title to the chart. The Chart tab should still be open. Click Chart 
Title  Above Chart:  

 

7.  The Edit Table dialog box will open. Type “2021 Financial Data (New England)” and 
click OK:  
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8.  The title will be added:  

 

9.  Now, let’s move the legend. Click Legend  Show Legend at Right:  
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10.  Review the changes:  

 

11.  Close the Excel browser tab to complete this activity.  
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Summary 
In this lesson, you learned how to organize worksheet data with tables and charts. With 
these tools, you will be able to take your workbooks a few steps further and learn more 
about your data than ever before. 

 

 

Review Questions 
1. What is the command sequence to format data as a table?  

 

2. What is a chart’s vertical axis also known as?  

 

3. How do you turn a table’s total row on or off?  

 

4. How do you move a chart?  

 

5. How do you add a title to a chart?  
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LESSON 6: 
USING PIVOTTABLES 

 

Lesson Objectives 

In this lesson you will learn how to: 

• Insert PivotTables 

• Work with PivotTable data 

• Sort and filter PivotTable data 

 

 

 



Microsoft 365 Excel: Online 

 

275 

TOPIC A: Inserting PivotTables 
An important function of any spreadsheet program is to help you derive meaning from your 
data. An Excel PivotTable is a great tool for doing this, as it can help you get different 
perspectives as you analyze the relationships between the columns and rows of your data. 
In this topic, you will learn what a PivotTable is and how to create one. You will also learn 
how to specify and rearrange PivotTable data.  

 

Topic Objectives 

In this session, you will learn: 

• What a PivotTable is 

• How to create and use a PivotTable 

• About the PivotTable Fields task pane 
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What is a PivotTable?  

A PivotTable is a powerful tool for exploring, summarizing, and analyzing information. A 
PivotTable helps you organize and manipulate the raw data in your spreadsheet to provide 
insight into patterns or relationships that might not be obvious at first glance. PivotTables 
also give you the power to summarize your data and view it in a different context, without 
changing the original content or structure of the data in the worksheet.  

With a PivotTable, you can conveniently drag and drop columns of your data to different 
areas of the table to examine relationships or trends that may not be obvious in a 
traditional Excel table.  

Rather than build several regular tables to explore how columns from an Excel worksheet 
relate to each other (or to see the data summarized in different ways), you can use one 
PivotTable to do the same thing. With a PivotTable, you can alter the table design without 
cutting, copying, pasting, or adjusting formulas and cell references. In short, PivotTables 
enable you to organize your data in meaningful ways, without doing a lot of tedious work. 
You could say that a PivotTable is like several data tables rolled into one. 

Ideally, the source data for a PivotTable should be structured like a traditional Excel table or 
database. The source data should have unique column headings distinguishing the data, and 
there should be no empty columns or rows within the data. 
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Creating a PivotTable 

To create a PivotTable, select the range of data on which you want to base the table, and 
then click Insert  PivotTable:  
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The Insert PivotTable menu will open. Using the Source field, you can select the range of 
data to be included in the PivotTable. In this example, the source is the table we already 
selected:   
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Under the PivotTables heading, you will see a list of different PivotTables you can add. 
PivotTables can be created in a new sheet, or can be added to an existing sheet. To create a 
new, blank PivotTable, click an option under the Create your own PivotTable heading:  

 

 

  



Microsoft 365 Excel: Online 

 

280 

Below this first option, you will also see some PivotTables that have been automatically 
generated based on different sets of data from your table. To use one of these pre-made 
tables, click an option under the desired table:   
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Here, we have added a new PivotTable to a new sheet:  

 

Now, we can add information to it by placing checks in the boxes next to the fields in the 
PivotTable Fields pane. As you do this, the PivotTable itself will be populated with the 
corresponding data: 
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The PivotTable Fields Task Pane 

When you insert a PivotTable into your workbook, the PivotTable Fields task pane will 
automatically be displayed on the right side of the Excel window:  

 

Let’s review each area.  

1. The left portion of this pane lists all of the fields from the dataset. To add or remove 
a field from the PivotTable, toggle the corresponding checkbox. Alternatively, to give 
you more control over field placement on the PivotTable, you can click and drag 
these fields to the PivotTable itself.  

2. Dragging fields to the Filters area will include those field values as filter criteria.  
3. The Columns area will create columns out of unique field entries.  
4. Similarly, the Rows area will create rows out of unique field entries.  
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5. Finally, fields that are dragged to the Values area will have calculations performed 
on them or their values summarized.  

All fields in areas 2-5 will include a pull-down arrow that contains commands to move the 
field to another area of the task pane (or remove it entirely).  

Remember that any changes you make in the PivotTable Field List pane will be applied 
dynamically. Additionally, due to the flexible nature of PivotTables, you can add or remove 
fields to or from this task pane at any time.  

 

Working with PivotTable Data 

As mentioned previously, the easiest way to add data to the PivotTable is to place 
checkmarks next to the desired fields in the PivotTable Fields task pane. You can just as 
easily remove the fields from the table by clearing the checkmarks.  

The order in which you click to place your checkmarks is very important, as this will also be 
the order of placement for the fields in the PivotTable. In this example, the Rows section 
contains the Full Name field followed by the Region field: 
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Watch what happens when we drag the Region field above the Full Name field:  

 

You can see that the names are now organized by region.  
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Watch what happens when we add the Sub-Region field below the Region field:  

 

You can see that this has created yet another level of organization. 
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As a final note, you can access Move commands from each field’s drop-down menu. Note 
that there is also an option here to remove the field from the PivotTable entirely: 
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Activity 6-1:  Inserting PivotTables 

In this activity, you will create a PivotTable and experiment with its data.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 6-1 from 
OneDrive. (Refer back to Activity 1-2 and Activity 1-3 if you need help.)  

2.  The Financial Data worksheet should be active. Click on a cell in the table, and then 
click Insert  PivotTable:  
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3.  The Insert PivotTable menu will open. The Source field should say “Table1”. Click 
New Sheet under the Create your own PivotTable heading:  

 

4.  A new worksheet will be created with the PivotTable:  
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5.  In the PivotTable Fields pane, check the City, State, and Net Profit fields. Observe 
the results:  

 

6.  In the Rows area, drag the State field above the City field:  
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7.  Review the results:  

 

8.  Let’s see the summarized values broken down a bit further. Drag the Office Type 
field to the Columns area:  
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9.  Review the results:  

 

10.  Close the Excel browser tab to compete this activity.  
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TOPIC B: Working with PivotTable Data 
Now that you know how to create a PivotTable and pivot data, it is time to learn about 
some of the other options that Excel provides for manipulating this data. In this lesson, you 
will learn about expanding and collapsing data, refreshing the data source, renaming fields, 
summarizing values, and changing value display. 

 

Topic Objectives 

In this session, you will learn how to: 

• Expand and collapse data 

• Refresh data 

• Rename fields 

• Summarize values 

• Change value display 
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Expanding and Collapsing Data 

You can view more or less PivotTable data by expanding or collapsing it. A minus (-) sign 
means you can collapse the data down:  
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While a plus (+) sign means you can expand it:  

 

In the first picture, we can see the two sub-regions of Asia and all the details. In the second 
picture, this data has been collapsed, so we can just see the top level of the data: Asia.  
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Remember that these levels are defined by the fields’ positions in the Rows section of the 
PivotTable Fields task pane:  

 

 

  



Microsoft 365 Excel: Online 

 

296 

Refreshing Data 

If your source data has changed, but the PivotTable is not reflecting those changes, you can 
trigger a refresh by right clicking the PivotTable and clicking Refresh: 

 

 

  



Microsoft 365 Excel: Online 

 

297 

Using the Value Field Settings Menu 

The Value Field Settings dialog box can be used for a number of purposes. To open this 
dialog box, click the dropdown arrow next to a field in the Values area:  
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Then click Value Field Settings:  

 

The Value Field Settings menu will open:  

 

 



Microsoft 365 Excel: Online 

 

299 

Summarizing Values 

Using the Value Field Settings menu, we can change the type of calculation being applied to 
the field. Right now, our PivotTable is showing the sum of all the sales made in Q1:  
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Let’s say we want to see the average of all sales instead. To start, we will click the dropdown 
arrow next to the field in the Values area of the PivotTable Fields task pane and click Value 
Field Settings:  

 

The Value Field Settings dialog box will open to the Summarize Value By tab. Choose the 
new calculation and click OK:  
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The new calculation will be performed. Notice that the column header has changed, too:  
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Changing Value Display 

The Value Field Settings menu has another tab: Show Values As.  

 

These options allow you to perform advanced functions on the selected field, such as 
showing running totals or percentages. Simply set your options and click OK to apply the 
change.  
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Activity 6-2:  Working with PivotTable Data 

In this activity, you will customize the financial data PivotTable you created in the last 
activity.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 6-2 from 
OneDrive.  

2.  Click inside the PivotTable to show the PivotTable Fields task pane:  

 

(If the task pane is already displayed, skip this step.)  

3.  We want to focus on the average profit by branch type and state. Click the minus 
sign beside each state abbreviation to collapse the data:  
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4.  Now, click the dropdown arrow next to the Sum of Net Profit field in the Values 
area of the PivotTable Fields task pane:  

 

5.  Click Value Field Settings:  
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6.  The Value Field Settings dialog box will open to the Summarize Value By tab. Click 
the Average function from the list:  

 

7.  Then, click the Custom Name field. Change the word “Sum” to “Average” and 
remove the word “of”:  
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8.  Click OK to apply the changes:  

 

9.  Review the results:  

 

(Notice that Excel has re-added the word “of” since it is a required convention.)  

10.  Close the Excel browser tab to complete this activity.  

 

  



Microsoft 365 Excel: Online 

 

307 

TOPIC C: Sorting and Filtering PivotTable Data 
 

The final topic we will explore is how to sort and filter PivotTable data. If you have 
completed the lessons on sorting and filtering worksheet and table data, you will notice that 
these tasks are almost exactly the same with PivotTables, although there are some 
additional options available.  

 

Topic Objectives 

In this session, you will learn how to: 

• Sort PivotTable data 

• Use the Filters pane 

• Use label and value filters 

• Clear filters 
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Sorting Data 

To sort PivotTable data, click the Row Labels or Column Labels dropdown arrow (depending 
on what you want to sort), choose the field you want to sort by, and choose the desired sort 
type: 

 

In addition to the Sort Ascending and Sort Descending options we have seen previously 
(which will sort the data in those fields), the Sort By Value command opens the following 
dialog box:  

 

These additional options will sort the numerical data in the PivotTable rather than the row 
or column headers.  
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Using the Filters Pane 

You can use the Filters area of the PivotTable Fields pane to filter the PivotTable data. For 
this example, let’s filter by region:  

 

Now, we will see a Region menu at the top of the PivotTable. Let’s click the dropdown 
arrow to get started:  
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The Filter dialog box will open. Here, we can check the region(s) we want to view and click 
OK:  

 

Here are the results:  

 

Notice that the Region filter menu shows that the data is being filtered. We can click this 
filter icon to reopen the Filter dialog box and modify our settings.  
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Using Label and Value Filters 

You can also access filtering options from the Row Labels and Column Labels dropdown 
menus:  

 

The Filter command will open the dialog box we just looked at, while the Label Filters and 
Value Filters menus work in the same way as the filtering options discussed in Lesson 2E:  
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Remember, clicking each of these commands will open the Custom Filter dialog box pre-
populated with the selected operator. You can then enter the criteria required. Here is an 
example:  

 

(Notice that you can change the field being filtered and the operator from this dialog box.)  

 

Clearing Filters 

There are two ways to clear a filter. If you have applied it from the Row Labels or Column 
Labels menu, you can also clear it from there:  
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If you have applied the filter from the PivotTable Fields task pane, click the dropdown arrow 
and click Remove Field:  
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Activity 6-3:  Sorting and Filtering PivotTable Data 

In this activity, you will sort and filter your financial data PivotTable.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 6-3 from 
OneDrive.  

2.  Click inside the PivotTable to show the PivotTable Fields task pane:  
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3.  First, let’s move the Office Type field from column display to a filter. To do this, we 
will drag and drop the field from the Columns area to the Filters area in the 
PivotTable Fields task pane:  

 



Microsoft 365 Excel: Online 

 

316 

4.  Now let’s use this filter. Click the dropdown arrow in cell B2:  
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5.  The Filter dialog box will open. Uncheck the Co-Owned and Franchise values 
(leaving only Corporate) and click OK:  

 

This means that only rows with Corporate as the Office Type will be shown in the 
PivotTable.  

6.  The filter will be applied:  
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7.  Next, we want to sort the states by their average profit. Click the Row Labels 
dropdown menu:  

 

8.  Choose State (as this is the field we want to sort) and click Sort By Value:  
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9.  Ensure “Average of Net Profit” is selected for the value. Choose the Largest to 
Smallest radio button. Click OK to apply the sort:  

 

10.  Review the results. Then, take a moment to think about the different ways you 
have viewed this data:  

 

11.  Close the Excel browser tab to complete this activity.  
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Summary 
This lesson was all about PivotTables. You should now feel comfortable inserting, modifying, 
and using PivotTables. You should also be able to sort and filter PivotTable data. 

 

Review Questions 
1. How do you create a PivotTable?  

 

2. What contextual tabs are available when working with PivotTables?  

 

3. How do you refresh PivotTable data?  

 

4. How do you change the type of calculation performed on PivotTable values?  

 

5. How do you sort PivotTable data?  
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LESSON 7: 
FINALIZING WORKBOOKS 

 

Lesson Objectives 

In this lesson you will learn how to: 

• Use comments 

• Manage worksheets 

• Change view options 
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TOPIC A: Using Comments 
Comments are a key part of Excel Online’s collaborative features. In this topic, we will learn 
all about comments, including how to insert, edit, reply to, navigate through, and delete 
them.  

 

Topic Objectives 

In this session, you will learn how to: 

• Insert, edit, and delete comments 

• Show and hide the Comments pane 
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Inserting Comments 

To insert a comment, select the cell you want to comment on. Then, click Review  New 
Comment:  

 

You can also click Insert  New Comment, or right-click a cell and click New Comment:  
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Then, a comment bubble will open. Type your comment into the appropriate area. When 
you are finished, click the Send arrow or press Ctrl + Enter:  

 

The comment will then be added, and indicated with a speech bubble icon in the workbook:  

 

The comment can be viewed by clicking the speech bubble icon.  

To edit a comment that has been posted, click the ellipses (…) in the top-right corner of the 
comment, and click Edit Comment:  
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Then type your change, and click the Send arrow:  

 

 

Showing and Hiding the Comments Pane 

You can open the Comments pane by clicking Review  Show Comments:  

 

This allows you to see all of the comments on the slide in a list, navigate to other comments 
in the presentation, and create new comments.  

  



Microsoft 365 Excel: Online 

 

326 

You can close the Comments pane with the X in its top right corner:  

 

 

Replying to Comments 

To reply to a comment, make sure the comment is selected, either by clicking the speech 
bubble icon, or opening the Comments pane:  
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Then, type your reply in the indicated field:  

 

 

Click the Send arrow to post your reply:  
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Deleting Comments 

To delete a comment, make sure the comment is selected, click the ellipses (…) in the top 
right corner, and click Delete thread:  
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Activity 7-1:  Working with Comments 

In this activity, you will review comments in a workbook, and add comments of your own.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 7-1 from 
OneDrive. (Refer back to Activity 1-2 and Activity 1-3 if you need help.)  

2.  The Financial Data sheet should be active. Look closely at cells A2 and H22. You will 
see a purple icon that denotes a comment:  

 

3.  Let’s take a closer look at these comments. Click Review  Show Comments to 
open the Comments task pane:  
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4.  Read the first comment, associated with cell A2:  

 

5.  Jane has asked for data about the state and office type for each row. This data is 
present, but we hid it during a previous activity. Let’s unhide it. To start, select 
columns A and D: 
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6.  Right-click the column headers and click Unhide Columns:  

 

7.  The data will now be shown. Since we have addressed Jane’s comment, let’s delete 
it. Start by clicking the ellipses (…) icon in the top corner of the comment in the 
Comments pane:   
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8.  Then click Delete thread:  
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9.  Finally, you think that Hebron might have the wrong state entered, so you want to 
add a note to remind you to double-check the data. Right-click cell A19 and click 
New Comment:  
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10.  In the Comments pane, type, “Confirm state is correct” and click the Send arrow:  

 

11.  Your comment will be created:  

 

12.  Close the Excel browser tab to complete this activity.  
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TOPIC B: Managing Worksheets (Part One) 
So far, we have worked with single worksheets within a workbook. However, like its 
desktop counterpart, Excel Online allows you to create and customize additional 
worksheets. In fact, there are so many customization options we will explore them through 
two topics. 

 

Topic Objectives 

In this session, you will learn how to: 

• View, insert, duplicate, and delete worksheets 

• Use worksheet references in formula 
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Viewing Worksheets 

To view a worksheet, click its tab:  

 

Its data will then be displayed in the main window.  
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Inserting Worksheets 

To insert a new worksheet, perform one of the following commands:  

• Click Home  Insert  Insert Sheet 

• Click the New Worksheet (+) icon on the row of sheet tabs 

• Right-click a worksheet tab and click Insert 

The new worksheet will be inserted, ready for your content:  
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Deleting Worksheets 

To delete a worksheet, ensure that the worksheet that you would like to delete is open and 
then click Home → Delete → Delete Sheet, or right-click the tab for the worksheet in 
question and click Delete:  

 

In either case, a warning dialog box will appear asking for confirmation to delete the 
selected worksheet. Click OK to complete the process:  
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Duplicating Worksheets 

To create a copy of a worksheet, right-click its tab and click Duplicate:  
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A copy of the worksheet will immediately be created:  
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Worksheet References in Formulas 

Formulas can contain references to any cell within any worksheet in the current workbook. 
They use the format ‘Sheet_Name’!, followed by the cell or cell range. Here, a formula is 
used to reference the sum of a column of data from “Sheet3”:   
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Activity 7-2:  Managing Worksheets (Part One) 

In this activity, you will update the structure of your financial data workbook so that more 
information can be included.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 7-2 from 
OneDrive.  

2.  First, click each worksheet tab and review the data in the workbook:  
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3.  The metrics on the Financial Scorecard tab are no longer required, so let’s delete 
this worksheet. Ensure that this worksheet is active and click Home  Delete  
Delete Sheet:  

 

4.  Click OK to confirm the operation:  
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5.  Now, the Financial Data sheet should be displayed. Let’s create a copy of it to use 
as a template for future years. Right-click the worksheet tab and click Duplicate:  

 

6.  A copy of the worksheet will be created:  
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7.  Finally, we need to add a new, blank worksheet that will contain a regional 
directory. Click the plus sign at the end of the worksheet tab list:  

 

8.  The new sheet will be added:  

 

9.  Close the Excel browser tab to complete this activity.  
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TOPIC C: Managing Worksheets (Part Two) 
 

In this topic, we will conclude our exploration of managing worksheets with a look at hiding, 
showing, reordering, and renaming worksheets. We will also learn how to change the 
worksheet tab color.  

 

Topic Objectives 

In this session, you will learn how to: 

• Hide and unhide worksheets 

• Reorder and rename worksheets 

• Change a worksheet tab’s color 
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Hiding and Unhiding Worksheets 

If you are working with a workbook that includes a lot of worksheets, it can quickly become 
cluttered. To focus on the worksheets that matter, you can choose to hide selected 
worksheets. Hidden worksheets are not deleted and still operate normally; they are just 
hidden from view.  

To hide the currently active worksheet, click Home → Format → Hide & Unhide → Hide 
Sheet, or right-click the tab and click Hide:  

 

Once a worksheet has been hidden, you will no longer be able to see or select its worksheet 
tab.  
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To unhide a worksheet, click Home → Format → Hide & Unhide → Unhide Sheet, or click 
the Unhide command on any tab’s right-click menu:  

 

The Unhide dialog box will open. Click to select the sheet that you would like to unhide and 
then click OK:  

 

The sheet will now be visible, and its tab will be displayed in its previous position.  
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Reordering Worksheets 

The quickest way to reposition a worksheet is to click and drag the worksheet tab:  

 

Once your mouse is in position, release your mouse button to complete the operation:  
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You can also right-click the worksheet tab and click Reorder:  

 

With either command, the Move selected sheet dialog box will open. Choose the sheet 
before which you want to place the selected sheet, and click OK:  
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The worksheet will now be moved:  

 

 

Renaming Worksheet Tabs 

To rename a worksheet tab, right-click it and click Rename (or simply double-click it):  
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The Rename Sheet dialog box will open. Enter the new name and click OK:  

 

The change will be applied:  
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Changing Tab Color 

To change the color of a worksheet tab, right-click the tab, click Tab Color, and choose the 
desired color:  

 

The new color will now be applied:  

 

To remove the color, choose No Color from the Tab Color menu.  
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Activity 7-3:  Managing Worksheets (Part Two)  

In this activity, you will finish setting up your financial data workbook structure.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 7-3 from 
OneDrive.  

2.  First, let’s ensure all the worksheets are properly named. Double-click the first 
worksheet tab (Sheet1):  

 

3.  The worksheet will be displayed, and the Rename Sheet dialog box will open. Type, 
“PivotTable” and click OK:  
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4.  The worksheet will be renamed. Now, right-click the Financial Data (2) tab and 
click Rename:  

 

5.  The Rename Sheet dialog box will open. Delete “(2)” from the text field and type 
“Template”. Click OK:  

 

6.  The worksheet will now be renamed. Finally, open the Rename Sheet dialog box 
for Sheet2 by double-clicking its tab or using the right-click menu. When the 
Rename Sheet dialog box opens, enter “Regional Directory” for the name and click 
OK:  
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7.  Now that the sheets are renamed, let’s update the order. Drag the Financial Data 
tab to the second position in the list:  

 

8.  Let’s update its color, too, since it is the most important sheet in the workbook. 
Right-click the Financial Data worksheet tab, click Tab Color, and choose any shade 
of green or blue: 
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9.  The change will be applied:  

 

10.  Close the Excel browser tab to complete this activity.  
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TOPIC D: Changing View Options 
 

If you have used the desktop version of Microsoft Excel, you probably know that there are 
many ways to customize the view of each workbook. Although Excel Online’s options are 
more limited, they can be useful in your day-to-day work. 

 

Topic Objectives 

In this session, you will learn how to: 

• Show and hide workbook elements 

• Freeze and unfreeze panes 
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Showing and Hiding Workbook Elements 

Open the View tab, and locate the Show group:   

 

This group allows you to show or hide different workbook elements by toggling the related 
icon on or off.  
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The Freeze Panes Options 

It is sometimes convenient to be able to keep an eye on one part of a spreadsheet while 
simultaneously viewing other parts of the same spreadsheet. You can do this using the 
Freeze feature.  

To use Freeze, open a workbook window and click View  Freeze Panes:  

 

The following options will be displayed:  

Freeze Panes If you select cells before clicking this option, everything to the 
left of and above the selection will remain frozen.  

Freeze Top Row This will freeze the top row. Use this option to keep column 
headings visible while scrolling vertically through the data.  

Freeze First Column This will freeze the first column. Use this option to keep row 
headings visible while scrolling horizontally through the data.  
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Activity 7-4:  Changing View Options 

In this activity, we will explore the view options in Excel Online.  

1.  To begin, open Microsoft Edge, log into Office 365, and open Activity 7-4 from 
OneDrive.  

2.  Let’s explore some view options. Click the View tab:  

 

3.  Since our Financial Data worksheet is complete, let’s turn off the gridlines by 
unchecking that box:  
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4.  Review the changes. Now, switch to the Financial Data Template sheet:  

 

5.  Notice that the gridlines are still visible here. However, we want to freeze the 
header row on this sheet as more data may be added to future reports. Click 
Freeze Panes  Freeze Top Row:  
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6.  Scroll down in the workbook. Notice that the first row remains in place:  

 

7.  Close the Excel browser tab to complete this activity.  
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Summary 
In this lesson, we learned about finalizing workbooks. You should now be able to use 
comments, manage worksheets, and change view options.  

 

 

Review Questions 
1. What is the easiest way to create a copy of a worksheet?  

 

2. How do you add a comment to a cell?  

 

3. What does the Freeze Panes command do?  

 

4. What is the format of formula references to other worksheets?  

 

5. How do you clear the color from a worksheet tab?  
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LESSON LABS 

 

Lesson 1 
Lesson Lab 1-1 

Objective To set up a sales report workbook.  

Briefing Before you start working on the data in a sales report, you 
want to make sure it is accessible and print a hard copy.  

Task • Open the Sample Data file from OneDrive in Excel 
Online.  

• Run the Accessibility Checker and resolve any issues.  
• If you have a printer, print a copy of the workbook. (If 

you do not have a printer, you can skip this step.)  

Hints If you cannot remember where to find a feature, or are not 
sure how to do something, consult Excel’s Help articles.  

Sample Data 
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Lesson 2 
Lesson Lab 2-1 

Objective To add formulas to the sales report.  

Briefing You need to organize the sales data by region, and calculate 
totals and key metrics.  

Task • Add a formula in cells E4 to E27 to calculate the profit 
for each store. (to do this, you will need to subtract 
expenses from sales.)  

• Sort the Sales Overview data by region.  
• Use copy and paste to enter the five regions in Column 

I, starting at I4.  
• Create a formula to calculate the average for each 

region.  

Hints Remember, there are a few different ways to create formulas.  

Sample Data 
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Lesson Lab 2-2 

Objective To improve the formatting in the sales data worksheet.  

Briefing You want to use the tools you learned about in this lesson to 
improve the appearance of your sales data worksheet.  

Task • Resize all columns on both sheets to fit their contents.  

• Move the Average Profit section to Sheet2.  

Sample Data 
 

 

  



Microsoft 365 Excel: Online 

 

368 

Lesson 3 
Lesson Lab 3-1 

Objective To continue improving the formatting in the sales data 
worksheet.  

Briefing You want to apply a proper format to the number values in the 
worksheet. You also want to apply borders to differentiate the 
regions.  

Task • Apply the Currency number format to the Sales, 
Expenses, Profits, and Average values in the workbook. 
(Remember that there are two worksheets.) Do not 
include decimal places.  

• Use a bottom border to separate the five regions on 
Sheet1.  

Hints You may need to re-adjust the column size after applying the 
number format.  

Sample Data 
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Lesson Lab 3-2 

Objective To format the titles and header rows in your sales workbook.  

Briefing You have ideas for making the Sample Data workbook even 
easier to read.  

Task Format the titles and header rows on both worksheets of the 
Sample Data file. Use font formatting, borders, and/or fills to 
make them stand out.  

Then, apply conditional formatting to Sheet1 to highlight any 
profits under $500,000. Use any formatting you like.  

Hints Use the Format Painter to speed up this task.  

Sample Data 
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Lesson Lab 3-3 

Objective To update a workbook using Find and Replace.  

Briefing You have been informed that this workbook is using the wrong 
terminology to describe its sales districts.  

Task • Replace the term “Central” with “Main”.  

• Replace the term “Region” with “District”.  

Hints Make sure to search in the entire workbook.  

Sample Data 
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Lesson 4 
Lesson Lab 4-1 

Objective To practice adding shapes to an Excel worksheet.  

Briefing Your manager wants to be able to quickly see which store has 
the highest profit.  

Task Add a star next to the highest profit on Sheet1. Format it to 
match the worksheet.  

Hints Use the Insert tab to create shapes and the Shape tab to 
format them.  

Sample Data 
 

Follow-Up Question Is there a function you could use to quickly find the highest 
number? 
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Lesson Lab 4-2 

Objective To enhance your workbook with pictures.  

Briefing You have received three pictures from the marketing team. You 
want to add two of these pictures to your workbook.  

Task Review the three Sample Data pictures. Add one picture to each 
sheet in the Sample Data file. Crop, resize, and move it to an 
appropriate location.  

Hints The pictures will need to be uploaded from your PC.  

Sample Data 
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Lesson 5 
Lesson Lab 5-1 

Objective To use tables to prepare for data analysis.  

Briefing After learning about tables, you realize how helpful they would 
be in your sales report.  

Task Convert the data on Sheet1 of the Sample Data file to a table. 
Enable both the header and total row.  

Hints Both the Home and Insert tabs have commands to format a 
range as a table.  

Sample Data 
 

Follow-Up Question If necessary, resize columns and reposition worksheet 
elements (like pictures and shapes) after creating the table.  
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Lesson Lab 5-2 

Objective To practice creating and modifying charts.  

Briefing You have decided to add a chart to show the data on Sheet2.  

Task • Review the chart types available in Excel Online. Then, 
choose an appropriate type for the data on Sheet2.  

• Ensure your chart has a legend and a vertical axis title.  

• Explore other elements, such as labels and data tables, 
and add at least one item.  

• Delete the picture and move the chart to its position.  
• Resize the chart if necessary.  

Hints The Chart tab will be useful for these tasks.  

Sample Data 
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Lesson 6 
Lesson Lab 6-1 

Objective To practice using PivotTables.  

Briefing Your manager has asked to see the average sales, expenses, 
and profits by district. You think a PivotTable is the best way to 
show this.  

Task Create a PivotTable on a new worksheet using the data from 
Sheet1. Set up the fields so the PivotTable shows the average 
sales, expenses, and profits by district. Apply the Currency 
number format to the results.  

Hints Additional tips to make the task easier for students. 

Sample Data 
 

Follow-Up Question Try filtering out the Main region and observe the result.  
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Lesson 7 
Lesson Lab 7-1 

Objective To organize the worksheets in the Sample Data file.  

Briefing You would like to organize the worksheets in the sales data 
workbook.  

Task • Give each sheet an appropriate name and a different 
color.  

• Move the Average Profit worksheet to the beginning of 
the tabs list, and the PivotTable worksheet to the end.  

• Ensure gridlines are displayed on all tabs.  

Hints Remember that there are multiple ways to manage 
worksheets, including the worksheet tab right-click menu and 
the Home  Format menu.  

Sample Data  
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Lesson Lab 7-2 

Objective To clarify items in a worksheet using comments.  

Briefing You are ready to submit your sales data report to your 
manager. You want to add comments to a few items in your 
workbook before doing so.  

Task Add the following comments to the Sample Data file:  

• Average Profit sheet, cell B3: “Data is linked to the Q1 
Sales Overview (Data) sheet.”  

• Q1 Sales Overview (Data) sheet, cell E3: “Profits under 
$500,000 are highlighted in red using conditional 
formatting.”  

• Q1 Sales Overview (Data) sheet, cell E28: “This total can 
be toggled on or off by clicking Home  Format as 
Table  Toggle Total Row.”  

• Q1 Sales Overview (Data) sheet, cell J2: “Image 
provided by marketing team.”  

• Q1 Sales Overview (PivotTable) sheet, cell A3: “Main 
District filtered out per accounting team. Click Row 
Labels  Clear Filter from District to view.”  

Then, show the Comments pane to review all of your 
comments.  

Hints You will find comment-related commands on the Review tab.  

Sample Data  

Follow-Up Question Delete the comment from cell E28 of the Q1 Sales Overview 
(Data) sheet.  
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COURSE WRAP-UP 

Post-Course Assessment 
1. The term ______________ describes a vertical series of cells.  

a. Workbook 

b. Worksheet 

c. Column 

d. Row 

e. Formula 

 

2. The term ______________ describes a horizontal series of cells.  

a. Workbook 

b. Worksheet 

c. Column 

d. Row 

e. Formula 

 
3. How do you open the Insert Function dialog box? (Select all that apply.)  

a. Click Insert  Function 

b. Click the Insert Function button on the formula bar 

c. Use the Alt + F shortcut 

d. Click Data  Functions 
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4. How do you refresh PivotTable data?  

a. Click PivotTable  Refresh 

b. Use the F5 shortcut 

c. Click Data  Refresh PivotTable 

d. Right-click the PivotTable and click Refresh 

 

5. How do you turn a table’s header row on or off?  

a. Convert the table to a PivotTable 

b. Click Home  Format as Table  Toggle Header Row 

c. Hide the header row 

d. All of the above 

 
 
6. What types of graphics can you add to an Excel Online workbook? (Select all that 

apply.)  

a. Pictures from your computer 

b. Pictures from the internet 

c. Shapes 

d. Emojis 

 

7. How do you create a new comment?  

a. Click Review  New Comment 

b. Click Insert  Comment 

c. Right-click the cell and click Insert Comment 

d. All of the above 
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8. Formulas always start with what symbol?  

a. / 

b. = 

c. \ 

d. : 

 
9. Which command sequence allows you to create a custom number format?  

a. Insert  Custom Format 

b. Home  Number Format  More Number Formats 

c. Data  Create Number Format 

d. Excel Online does not support custom number formats 

 
10. How do you change what data is displayed in a chart?  

a. Click Chart  Select Data 

b. Right-click the chart and click Select Data 

c. When the chart is selected, use the handles to modify the data selection 

d. You must delete and re-create the chart 
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Course Summary 
Congratulations on completing Microsoft Excel Online training. During this course, you 
learned how to: 

• Get started with Excel Online and describe its basic components 

• Manage workbooks 

• Get help in Excel Online 

• Use formulas and functions 

• Work with data, rows, and columns 

• Sort and filter data 

• Format text and cells 

• Align cell contents 

• Use Find & Select tools 

• Apply conditional formatting 

• Insert pictures and shapes 

• Format shapes 

• Create and modify tables and charts 

• Insert and use PivotTables 

• Sort and filter PivotTable data 

• Use comments 

• Manage worksheets 

• Change view options 

 

You should now feel comfortable creating a new spreadsheet, working with basic formulas 
and functions, and making a spreadsheet look professional and presentable.  
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ANSWER KEYS  

Lesson 1 Review Questions 
1. Where can Excel Online open documents from?  

Excel Online can open documents from Microsoft Cloud locations, such as OneDrive or 
SharePoint.  

 

2. What commands opens a menu that allows you to search for help articles in Excel 
Online?  

Help articles can be searched and accessed in the help menu, which is opened by 
clicking Help under the Help tab.  

 

3. In Excel, what is a column and a row?  

In Excel, the term column describes a vertical series of adjacent cells, while a row is a 
horizontal series of cells.  

 

4. True or False: Since Excel is a cloud-based application, you cannot save workbooks 
offline.  

This statement is false. You can access other save options by clicking File  Save As.  

 

5. How are cells typically referenced in Excel?  

By combining the column letter and the row number (ex. A1).  
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Lesson 2 Review Questions  
 

1. List one way to open the Insert Function dialog box.  

Click the Insert tab and click Function, or click the Insert Function button on the formula 
bar.  

 

2. How do you enable filtering?  

Click Home  Sort and Filter  Filter.  

 

3. How is Flash Fill different from AutoFill?  

AutoFill places data based on a pattern, while Flash Fill automatically extracts or 
combines data.  

 

4. In this equation, which operation will be evaluated first ? (5*10)+40/3 

The expression in the parentheses (5*10), will be evaluated first.  

 

5. What is the easiest way to completely clear a cell using the ribbon interface?  

Click Home  Clear  Clear All.  
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Lesson 3 Review Questions  
 

1. What does the Format Painter do?  

The Format Painter allows you to copy formatting from one part of your workbook to 
another.  

 

2. Formulas always start with what symbol?  

Formulas always start with the equals sign (=).  

 

3. When you select a range of data, where are automatic calculations displayed?  

Automatic calculations are displayed in the Status Bar.  

 

4. What commands are available on the Home  Merge & Center dropdown menu?  

The Merge & Center dropdown menu includes the Merge Across, Merge Cells, and 
Unmerge Cells commands.  

 

5. True or False: Cell references are case-sensitive.  

 False 
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Lesson 4 Review Questions  
 

1. What types of pictures can you insert in an Excel Online workbook?  

In Excel Online, you can only insert pictures from your computer.  

 

2. Which contextual tab provides shape formatting commands?  

The Shape tab.  

 

3. What does the Alt Text command for shapes and pictures do?  

Allows you to assign text to an object that can be used by screen readers to describe a 
picture to users with visual impairments.  

 

4. How do you resize a picture?  

Click it to select it. Then, click and drag any of the handles to resize the photo in that 
direction.  

 

5. How do you change a shape’s type?  

Click the shape to select it. Then, click Shape  Change Shape, and choose the new 
shape type.  
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Lesson 5 Review Questions  
 

1. What is the command sequence to format data as a table?  

Click Home  Format as Table or Insert  Table.  

 

2. What is a chart’s vertical axis also known as?  

The Y axis.  

 

3. How do you turn a table’s total row on or off?  

Click Home  Format as Table  Toggle Total Row.  

 

4. How do you move a chart?  

Click and drag it.  

 

5. How do you add a title to a chart?  

Click Chart  Chart Title, and choose the desired position.  
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Lesson 6 Review Questions  
 

1. How do you create a PivotTable?  

Select the range of data on which you want to base the table and then click Insert  
PivotTable.  

 

2. What contextual tabs are available when working with PivotTables?  

Excel Online does not have any contextual PivotTable tabs.  

 

3. How do you refresh PivotTable data?  

Right-click the PivotTable and click Refresh.  

 

4. How do you change the type of calculation performed on PivotTable values?  

Click the dropdown arrow next to the field in the Values area of the PivotTable Fields 
task pane and click Value Field Settings. You can then choose the new calculation on the 
Summarize Value By tab.  

 

5. How do you sort PivotTable data?  

Click the Row Labels or Column Labels dropdown arrow, choose the field you want to 
sort by, and choose the desired sort type.  
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Lesson 7 Review Questions  
 

1. What is the easiest way to create a copy of a worksheet?  

Right-click its tab and click Duplicate.  

 

2. How do you add a comment to a cell?  

Select the cell you want to comment on. Then, click Insert  Comment, or use the 
Insert Comment command on the right-click menu.  

 

3. What does the Freeze Panes command do?  

Freezes everything to the left of and above the selection.  

 

4. What is the format of formula references to other worksheets?  

‘Sheet_Name’!, followed by the cell or cell range.  

 

5. How do you clear the color from a worksheet tab?  

Right-click the tab, click Tab Color, and click No Color.  
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Post-Course Assessment 
1. The term ______________ describes a vertical series of cells.  

a. Workbook 

b. Worksheet 

c. Column 

d. Row 

e. Formula 

The term “column” describes a vertical series of cells.  

 

2. The term ______________ describes a horizontal series of cells.  

a. Workbook 

b. Worksheet 

c. Column 

d. Row 

e. Formula 

The term “row” describes a horizontal series of cells.  

 
3. How do you open the Insert Function dialog box? (Select all that apply.)  

a. Click Insert  Function 

b. Click the Insert Function button on the formula bar 

c. Use the Alt + F shortcut 

d. Click Data  Functions 

To open the Insert Function dialog box, click Insert  Function or the Insert Function 
button on the formula bar.  
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4. How do you refresh PivotTable data?  

a. Click PivotTable  Refresh 

b. Use the F5 shortcut 

c. Click Data  Refresh PivotTable 

d. Right-click the PivotTable and click Refresh 

To refresh PivotTable data, right-click it and click Refresh.  

 

5. How do you turn a table’s header row on or off?  

a. Convert the table to a PivotTable 

b. Click Home  Format as Table  Toggle Header Row 

c. Hide the header row 

d. All of the above 

To turn a table’s header row on or off, click Home  Format as Table  Toggle Header 
Row.  

 
6. What types of graphics can you add to an Excel Online workbook? (Select all that 

apply.)  

a. Pictures from your computer 

b. Pictures from the internet 

c. Shapes 

d. Emojis 

As of this writing, Excel Online supports pictures from your computer and shapes.  
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7. How do you create a new comment?  

a. Click Review  New Comment 

b. Click Insert  Comment 

c. Right-click the cell and click Insert Comment 

d. All of the above 

These are all ways to create a new comment.  

 

8. Formulas always start with what symbol?  

a. / 

b. = 

c. \ 

d. : 

Formulas always start with the equals sign (=).  

 
9. Which command sequence allows you to create a custom number format?  

a. Insert  Custom Format 

b. Home  Number Format  More Number Formats 

c. Data  Create Number Format 

d. Excel Online does not support custom number formats 

To create a custom number format, click Home  Number Format  More Number 
Formats.  
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10. How do you change what data is displayed in a chart?  

a. Click Chart  Select Data 

b. Right-click the chart and click Select Data 

c. When the chart is selected, use the handles to modify the data selection 

d. You must delete and re-create the chart 

The Select Data dialog allows you to change what data is displayed in a chart. To open it, 
click Chart  Select Data.  
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APPENDICES 

Keyboard Shortcut Quick Reference Sheet 

Ed
iti

ng
 C

om
m

an
ds

 

Cut Ctrl + X 

Copy Ctrl + C 

Paste Ctrl + V 

Undo Ctrl + Z 

Redo Ctrl + Y 

Start a new line in the same cell Alt + Enter 

Print worksheet Ctrl + P 

Se
le

ct
 C

om
m

an
ds

 

Select a range of cells Shift + Arrow keys 

Select a column Ctrl + Spacebar 

Select a row Shift + Spacebar 

Open the Find dialog Ctrl + F 

Open the Replace dialog Ctrl + H 

Open the Go To dialog Ctrl + G 
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Fo
rm

at
tin

g 
Co

m
m
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ds

 
Apply bold Ctrl + B 

Apply italics Ctrl + I 

Apply underlining Ctrl + U 

Increase font size Ctrl + Shift + > 

Decrease font size Ctrl + Shift + < 

Clear formatting Ctrl + D 

N
av

ig
at

io
n 

Co
m

m
an

ds
 

Move up one cell Up arrow / Shift+ Enter 

Move down one cell Down arrow / Enter 

Move right one cell Right arrow / Tab 

Move left one cell Left arrow / Shift + Tab 

Go to the beginning of the row Home 

Go to cell A1 Ctrl + Home 

Go to the last cell of used range Ctrl + End 

Move down one screen (28 rows) Page Down 

Move up one screen (28 rows) Page Up 

Move to the edge of the current data region Ctrl + Right arrow / Ctrl + 
Left arrow 

Switch to next sheet Alt + Ctrl + Page Down 

Switch to previous sheet Alt + Ctrl + Page Up 
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In
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Insert new worksheet Shift + F11 

Insert hyperlink Ctrl + K 

Follow hyperlink Ctrl + Enter 

Insert table Ctrl + L 

Open/close Comments pane Shift + F2 

Ca
lc

ul
at

e 
Da

ta
 

Calculate workbook (refresh data) F9 

Insert AutoSum function Alt + Equals (=) 

Open Insert Function dialog box Shift + F3 
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Glossary 
Absolute reference 
A type of reference that will not change even if it is moved or copied to another location.  

 

Arguments 
Data used by functions to complete calculations.  

 

AutoFill 
A feature that is used to automatically fill sequential data into a range of cells.  

 

Cell 
The intersection of a row and column on a worksheet.   

 

Charts 
Visual representation of numeric data.  

 

Conditional Formatting 
Formatting that will highlight cells whose data satisfies certain criteria.  

 

Filtering 
Customizing the data view based upon set criteria.  

 

Fill 
Formatting that adds background color to cell(s).   

 

Fill handle 
The small black box that appears in the bottom right-hand corner of a selected cell or cell 
range. Used to activate the AutoFill feature.  
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Flash Fill 
Feature that will automatically extract or combine data based on a pattern.  

 

Font 
A set of typefaces.  

 

Format Painter 
A tool that is used to copy formatting from one selection of text to another.  

 

Formula 
A mathematical relationship expressed through symbols.  

 

Formula Bar 
A part of the Excel interface that displays the cell name, contents, and/or formulas in a 
selected cell.  

 

Function 
Pre-made operations that are used to perform calculations.  

 

Mixed references 
Cell references that include both relative and absolute references.  

 

PivotTable 
A data analysis tool that dynamically allows you to pivot columns and rows of raw data 
without altering it.  

 

Relative reference 
A cell reference that will change relative to its positioning in a worksheet.  
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Spreadsheet 
Either a paper or electronic file that is used to store and work with data (mostly numbers) in 
a tabular fashion.  

 

Table 
A dataset that is comprised of rows and columns, but is treated as one object (unlike regular 
data ranges).  

 

Workbook 
An Excel file that stores multiple worksheets.  

 

Worksheet 
An electronic spreadsheet.  
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